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Notices

This document contains information proprietary to
FileNet Corporation (FileNet). Due to continuing
product development, product specifications and
capabilities are subject to change without notice. You
may not disclose or use any proprietary information or
reproduce or transmit any part of this document in
any form or by any means, electronic or mechanical,
for any purpose, without written permission from
FileNet.

FileNet has made every effort to keep the information
in this document current and accurate as of the date
of publication or revision. However, FileNet does not
guarantee or imply that this document is error free or
accurate with regard to any particular specification. In
no event will FileNet be liable for direct, indirect,
special incidental, or consequential damages
resulting from any defect in the documentation, even
if advised of the possibility of such dam-ages. No
FileNet agent, dealer, or employee is authorized to
make any modification, extension, or addition to the
above statements.

FileNet may have patents, patent applications,
trade-marks, copyrights, or other intellectual
property rights covering subject matter in this
document. Furnishing this document does not
provide any license to these patents, trademarks,
copyrights, or other intellectual property. FileNet is
a registered trademark. Copyright © 2001, 2003
FileNet Corp. All Rights Reserved.
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About This Manual

This manual is designed to assist the users to archive, retrieve and
display the documents through the Document Warehouse for SAP
(DWSAP) 5.1 product suite. The first chapter contains conceptual
information about DWSAP, and the subsequent chapters contain task-
oriented activities that enable the users to archive, retrieve or display the
documents. The following is an overview of the information that the
manual contains:

Chapter 1-Introduction — Introduces the DWSAP product.

Chapter 2-Document Processing — Explains various data archiving
methods and usage of FileNet IDM Desktop for R/3 Views.

Chapter 3-Document & Data Archiving — Explains various archiving
modes and archiving print lists to FileNet system.

Chapter 4-Document Retrieval & Display — Explains how to retrieve the
documents stored on the FileNet system and display them on a
workstation using either ArchivelLink viewer , FileNet IDM viewer or a
Java based viewer.

Chapter 5-Provides an overview of the DMS Sample Application.

Glossary-This is an alphabetically ordered list, which gives a quick
explanation to various important terms in this document.

Index—This is an alphabetically ordered list, which helps to locate
appropriate information easily.

Target Audience

This manual is designed for the user of the DWSAP product suite. The
user should be familiar with SAP.

New Features In This Release

Release 5.1 of the DWSAP has the following new features:

e Multiple simultaneous RFC requests.

e On-Line Administration.

¢ Windows Event Logging.

e SAP Namespace.

e Enhanced SAP Document Management System (DMS) support.

e Pure Thin Document Viewing.
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o FileNet Capture For R/3 support for Panagon Capture 4.0.
e DMS Viewing and Linking ASP Sample Application.

Tips, Notes, Cautions, And Background Information

Throughout this manual, there are assorted brief messages designed to
draw your attention to different kinds of information:

Tip: Indicates hints to improve efficiency of performing a task.

Note: Provides important information, such as situations that can affect
the outcome of an operation or affect some other part of the system

Background: Explains the concepts behind specific features and
provides helpful information for understanding the design of SAP
Archive Link and DWSAP.

CAUTION: Signals, where possible loss of data or time may occur

Bold Type Indicates menu names, menu items, component names

Blue text Indicates a link to another topic, a link to another section in the
same topic, or a link to an external topic.

Education

FileNet provides various forms of instruction. Please visit the Global
Learning Services in FileNet's Service & Support area at
www. FileNet.com.

Comments And Suggestions

FileNet invites all customers to communicate with the Documentation
group on any question or comment related to FileNet manuals and online
help. Send email to docs@filenet.com. We will make every effort to
respond within one week. Your suggestions help us improve the products
we deliver.
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1

Introduction

This chapter provides an overview of Document Warehouse for SAP
(DWSAP) 5.1 product suite. For a more detailed discussion of DWSAP,
refer to the FileNet DWSAP Installation and Configuration —Server .

Note: This manual contains periodic references to the SAP system where
it works in conjunction with DWSAP Server Components and the FileNet
IDM Desktop for R/3. These references are included for your
convenience, as examples only, and to provide a clear understanding of
DWSAP Server Components and FileNet IDM Desktop for R/3
procedures.

FileNet Document Warehouse For SAP

DWSAP integrates SAP and FileNet repositories like Image Serviices (IS)
or Content Services (CS) using SAP ArchiveLink interface. It enables the
business applications of SAP to process documents. It also allows
archiving and retrieval of document as well as data.

The applications in DWSAP are:

o FileNet IDM Desktop for R/3: FileNet IDM Desktop for R/3 is
installed on the client machine. It communicates with the SAPGUI
client through SAP ArchivelLink interface, and with Image Services
(IS) and Content Services (CS) using FileNet IDM objects.

o FileNet IDM Services for R/3: FileNet IDM Services for R/3 is
installed on the server machine. It integrates the IS with SAP to
provide automated document archiving and retrieval.

Note: FileNet IDM Services for R/3 will hereafter be called DWSAP
Server Components.

Using DWSAP, you can:

e Process incoming documents before, during, and after archiving to the
IS library. The archiving methods used are: early archiving, late
archiving, and simultaneous archiving. For more information on these
archiving methods, refer to section in Document Archiving Methods.

e Link the incoming documents to transactions in SAP system. To
access the FileNet documents from SAP system, the documents
should be indexed in SAP. This is called Document Indexing. This is
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done by associating the document with SAP link table, which is
performed automatically, when documents are linked to SAP
transaction using FileNet IDM Desktop for R/3. Business attributes are
not maintained for each archived document. Instead, the Link table in
SAP database maintains relationships between SAP business objects
and the documents associated with it.

e Link the incoming documents to work items that are routed and
processed, using the SAP Business Workflow.

e Archive outgoing SAP generated documents such as order
confirmations, print lists such as customer and vendor lists, and
document images such as faxes received, directly from SAP system
to IS library.

e Retrieve documents from IS that are linked to a transaction in SAP,
and display these documents at the workstation.

o Store SAP generated data archive (REO) files on an optical library,
instead of SAP application servers file system.

The following table contains examples of the types of documents in SAP
that support ArchivelLink. Check the SAP documentation help files for a
complete list for your release.

SAP Module

Original
documents

SAP-generated

Documents

Document Management
System (DMS)

Any document

Financial Accounting (FI) | Credit Memo Line ltem Journal
Invoice Full Audit Trail
Payment Classic Audit Trail
Document Journal
Human Resources (HR) | Applications

Contracts and
related

Correspondence
Photo of Employee

Regulatory
documents

Certificates.

Materials
(MM)

Management

Credit Memo

Invoice

LIFO valuation report
Outline Agreement
Purchase Order

Schedule Line
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Master Material

Sales & Distribution (SD)

Complaint
Contract

Delivery Note
Delivery Schedule
Order

Schedule
Agreement

Inquiry

Complaint

Contract

Credit Memo
Delivery Note
Delivery Schedule
Order Confirmation
Quotation

Schedule Agreement
Inquiry

Invoice

Workflow (WF)

Any document

Any document

The list of ArchiveLink-enabled applications and individual transactions
will increase over time. With ArchiveLink, the FileNet system will be able
to process these new document types without modification.
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2

Document Processing Using FileNet IDM

Desktop For R/3

Document processing consists of entering, distributing, and incrementing
data in appropriate modules on the SAP system. This data is taken from
the documents located on the FileNet system.

This chapter describes the various procedures to process data on SAP
system, using the FileNet IDM Desktop for R/3.

Note: SAP related screen shots are taken with SAP Application server
4.6B, so the actual screen in the users machine may differ from what is
given in this Operations manual.

This section provides an overview of document archiving methods and
then provides the procedure for document archiving using FileNet IDM
Desktop for R/3.

Document Archiving Methods

Document archiving in SAP refers to the action of classifying the
committed documents. FileNet commits all the documents prior to
processing them in the SAP system, regardless of the archiving method.
The archiving methods used to process documents are:

e Early archiving
e Simultaneous archiving

e Late archiving.

Early Archiving

This archiving method involves committing incoming documents to
FileNet libraries and routing the documents to another user for
processing. New work items are not forwarded directly to other users for
processing. Instead, new work items are placed in a central SAP
Workflow queue. This queue is emptied by a predefined job,
WF_PROCESS Job, on the SAP system. This job runs periodically, and
moves the new work items to specific Inboxes. This operation takes a few
seconds.
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Document Archiving Methods

Using the Early Archiving processing method, you can:

Create a work item in the SAP Workflow program, representing the
document to be processed. This workflow item can also be routed it to
the Inbox of another user.

Link the incoming document to the work item automatically.

Retrieve the work item from SAP Workflow and display the image of
the associated document.

Process the Document Type associated with the work item, and book
or post the document in an SAP application.

Create a permanent link between the document and the new SAP
transaction.

Simultaneous Archiving

The process of simultaneous archiving is similar to early archiving. In
simultaneous archiving, incoming documents are classified for processing
on the SAP system, and document's data is entered into the
corresponding SAP R/3 transaction. The difference between the two
methods of archiving is that the work item is not routed to another user for
processing in simultaneous archiving.

Late Archiving

The process of late archiving commits documents to FileNet, and
classifies the documents after processing them on SAP. Late Archiving
can be done with or without using bar codes on the incoming documents.

Late Archiving Without Using Bar Codes

While processing incoming documents without bar codes, you can:

Book the paper document into SAP system to create a new
transaction.

Note the transaction key on the SAP document for later reference.
Retrieve and display the document in the FileNet viewer.

Match an object in SAP application, using the SAP Object ID and
other key data from the displayed document.

Create an entry in the Link table, to link the object and the displayed
document.

Late Archiving Using Bar Codes

While processing incoming original documents using bar codes, you can:

Attach a unique bar code to each incoming document before it is
distributed for processing.
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o Book the paper document into SAP application and create a new SAP
transaction.

e Create a temporary link between the document and the SAP object.
This link is stored in SAP database.

o Retrieve the scanned document from a FileNet Workflow queue, and
send a message to SAP system containing the FileNet document id
and bar code value.

e Create a permanent link between the SAP transaction and the
document, using SAP Object ID and FileNet document id. To create
this link, match the message containing the FileNet document id and
bar code value with the temporary record. This action is automatically
performed by the cBarcode, which is a part of the DWSAP Server
Components.

Using FileNet IDM Desktop For R/3 For Incoming
Documents

FileNet IDM Desktop for R/3 main window represents the interface
between DWSAP application and the FileNet Image Services (IS) or
Content Services(CS).

The FileNet IDM Desktop for R/3 uses views to obtain a document from
either IS or CS library for processing. The following standard views are
provided with FileNet IDM Desktop for R/3:

e FileNet Browse for R/3.
o FileNet Capture for R/3.
e FileNet Queue for R/3.

Each of the above views is described in the later sections. Customers can
also develop their own views that can be plugged into the FileNet IDM
Desktop for R/3.

Accessing FileNet IDM Desktop For R/3

In order to access IDM Desktop for R/3, click Start > Programs - IDM
Desktop for R/3. To view the three standard views, click File = Open
iView menu; the following screen appears:

March 2003

FileNet Document Warehouse for SAP 13



Document Processing Using FileNet IDM Desktop For R/3
Using FileNet IDM Desktop For R/3 For Incoming Documents

7 FileMet IDM Desktop For R/3 - O =10 x|

Select a iview o oper:

Filetdet Browse For B2 Ok
FileMet Capture for B/3 —
Filetet Hueue For B3

FileNet IDM Desktop for R/3 can be used to perform following operations:

Open a view to link documents to SAP business transactions. To
open any view, select it in the Open iView dialog box, and click Ok.
The Open iView dialog box closes, and the chosen view appears as a
child window inside the main window.

Access already opened views. In order to find out which views are
currently open, click the Window menu; below the horizontal separator
line, all open views are displayed. Select any one of them to activate
the corresponding view.

Access Help and display the version for FileNet IDM Desktop for R/3.

Exit FileNet IDM Desktop for R/3 Application.To terminate an
application of FileNet IDM Desktop for R/3, click File = Exit menu.

Note: You can also double-click a view in the Open iView dialog box, to
open it. There can be none, one, or more views opened simultaneously.

Menu And Command Summary

The following tables summarize the menus and commands available in
the IDM Desktop for R/3 main window.

File Menu

Option Function

Open iView Opens a dialog that lets you choose a view
and open it.

Close Closes the currently active view.

Close All Closes all open views

Save Settings On Exit | A check marked menu to enable or disable
the saving of current settings automatically
when FileNet IDM for R/3 is closed. A
checkmark before this menu item will mean
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Option

Function

that this option is switched on.

Save Settings Now

Immediately saves the current settings.

Exit

Exits the FileNet IDM Desktop for R/3.

Window Menu

The options on the Window menu are:

Option

Function

Tile Horizontally

Tiles all open windows horizontally.

Tile Vertically

Tiles all open windows vertically.

Cascade

Cascade all open windows.

Arrange Icons

Arranges the icons of all minimized
windows.

<Open view>

Activates the view. There will be a Menu
item for each open view

Function

Displays FileNet IDM Desktop for R/3
help topics.

Displays the Search Tab of the online
help file.

Help Menu
The options on the Help menu are:
Option
Contents
Search
About

Displays product and version information
for FileNet IDM Desktop for R/3.

Archiving Incoming Documents

The following steps need to be performed to archive incoming documents
using FileNet IDM Desktop for R/3:

Note: Before carrying out the Archiving of Incoming Documents,
Customizing for archiving Incoming documents should be carried out as
mentioned in the Installation and Configuration Manual-Client.

1. Launch FileNet IDM Desktop for R/3. If there is no open child
window, open one of the views using the Open iView menu.

2. Logon to the desired IS library displayed in the tree view. The FileNet
IDM Desktop for R/3 shows all the FileNet Workflo workspaces and

queues in the selected IS.
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£ FileNet IDM Desktop For R/3 - [FileNet Queue For F =10 =]
ﬁ File Queue Window Help ;lilil
FileMet Meighborhood Caontents of "WaorkSpacel /Ausuel’ [Entries: 2]
E FileMET Meighbaorhood ‘
=i} IMGSERY
=] WorkSpacel

Ready.

Note: SAP will subsequently request that FileNet IDM Desktop for R/3 to
send the selected document number to be linked with SAP objects.

3. The first document of this Workflo Queue will be selected

automatically. The FileNet IDM Desktop for R/3 opens the FileNet
IDM Viewer to display the document.

Double-click the SAP icon from the Windows desktop or choose
SAPLogon from SAP R/3 program group to open the main window of
SAP R/3.

Logon to SAP System.

Click Office = Business Document 2> Documents > Move menu,
or transaction oawd to get the default settings for stored documents,
The following screen is displayed:
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Document  Edit Goto Seftings  Utilties stemn Help

& 0 B eae SHE DL BRI @m

Store documents
&y LTS

Default settings

Ir<1rv1

—C 411 Applications - NOT a summary

—a Asset Accounting

@ Engineering Change Management

8 Financial Accounting

—C8 Human Resources - Applicant Management
—C Human Resources - Employee Management
0 Human Resources - Travel Expenses
@ Materials Management

—CE Plants Maintenance

—E Quality Management

8 Sales & Distribution

—E A1 Bpplications

—E Asset Accounting

G Financial Accounting L
—C Human Resources - Applicant Management
—C Human Resources - Employee Management
—E Materials Management

—E Plants Maintenance

—E Quality Management

8 Sales & Distribution

—E A1 Bpplications

[T 1E

0| D]

[ | omwD Pl fretsap | NS

The default setting contains a list of work modules, where each work
module contains groups of related document types. These document
types classify the incoming original document to be processed. For
example, incoming invoices and credit memos are grouped under a work
module named Financial Accounting.

Note: Access to the default setting and associated document types can
be controlled through the security features in SAP System. For
information on security Features, see the appropriate SAP
documentation.

7. From the default settings window, double-click the desired work
module, such as Financial Accounting. The following screen is
displayed:
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Edit

Document Goto  Seftings  Utiliti

100 SaQ CHE IDLL BE @ m

Store documents
&y o S

& Financial Accounting E
— Incoming credit memo w/o verification BASIS IDES
— Incoming invoice w/o verification BASIS IDES
— Incoming invoice preliminary posting BASIS IDES
— §€ Incoming payment fast entry BASIS IDES
— §E Incoming payment BASIS IDES
— FAX BASIS IDES Il
— Doc Type FAX for M1 BASIS IDES
— PDOF Documen for archive pi BASIS IDES
— §€ Inconing document BASIS IDES
— haa BASIS IDES
— New Doc Type for Incoming Documents BASIS IDES
— Doc Type for 52 for incoming Documents  BASIS IDES
— Incominmg Doc type for T1 BASIS IDES |
— (¥P0oc Type POF for Archive T1 BASIS IDES
— Dac Type Far HTTP BASIS IDES
— PDF Doc type BASIS IDES
— Incoming Doc Type For X2 BASIS IDES
— FDF BASIS IDES
— §E test Doc type BASIS IDES
— Incoming invoice w/o verification BASIS IDES
— Incoming Invoice BASIS IDES E
— Incoming Doc Type for Archive Y2 BASIS IDES

[ [ L[]
@ Cancelled by user 2 [OAWD fhetsap | INS

8. Select the document type and click the Document menu. The
following drop down list is displayed.

Document  Edit Gota  Settings  Utilitie
§ Storing for subsequent entry B ROSHER DOLD I BEE @
_S Storing for subsequent assignment F&
Store and enter F7
¥ Store and assign Fa
Assign then store Fg [«
Eit Shift+F3 E
emo w/o verification BASIS IDES
— & Incoming invoice w/o verification BASIS IDES
— &€ Incoming invoice preliminary posting BASIS IDES
— £& Incoming payment fast entry BASIS IDES
— %€ Incoming paynent BASIS IDES
— &E FOY BASIS IDES |
— &E Doc Type FAX for M1 BASIS IDES
— &€ PDF Documen for archive pi BASIS IDES
—— £& Inconing document BASIS IDES
— &E haa BASIS IDES
— &E MNew Doc Type for Incoming Documents BASIS IDES
— &E Doc Type for 52 for incoming Documents  BASIS IDES
— &€ Incominmg Doc type for T1 BASIS IDES |
— & Doc Type POF for Archive T1 BASIS IDES
— (=l0oc Type For HTTP BASIS IDES
— & POF Doc type BASIS IDES
— & Incoming Doc Type For X2 BASIS IDES
— & FDF BASIS IDES
— {E test Doc type BASIS IDES
— & Incaming invoice w/o verification BASIS IDES
— & Incoming Invoice BASIS IDES E
— & Incoming Doc Type for Archive Y2 BASIS IDES o
<[] [ L[]

| D [ oawD Pl fetsap | INS

Select the following menu entries for different archiving methods:
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a. Storing for subsequent entry option for early archiving. The
following dialog box is displayed.

Staring for subseguent entry
Doc. type Doc Type FAK for M1
Fecipient BASIS IDES
Mote Doc Type FAX far W1

¥ B Mass archiving 38

Fill in the text description of the work item in the Note field. Click (V)
button.

Click Mass archiving button to process a batch of similar documents.

b. Storing and enter option for simultaneous archiving.

Stare and enter

Doc. tvpe Do Type FAR for i1
Fecipient BASIZ IDES
Mate Dioc Type FAX far w1

¥ B Mass archiving 3

Fill in the text description of the work item in the Note field. Click (V)
button.

Click Mass archiving button to process a batch of similar documents.

c. Assign then store option for late archiving without using barcodes.

Accounting docurment

Company code @
Document number
Fiscal year

W &p Ohject 2 Ohject 3

Enter the necessary information according to the selected System
Setting and document type. To continue, click the (V) button.

SAP sends an OLE request to FileNet IDM Desktop for R/3, to obtain the
document number of the top most selected item. After the document
number is sent to SAP, FileNet IDM Desktop for R/3 deselects the item,
or removes the document from the queue, and automatically selects the
next document in the queue.

If Mass Archiving has been chosen, an identical work item is created for
each document, and all selected documents, or remaining items in the
selected FileNet Workflo queue are processed automatically.
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When the queue is empty, processing stops and FileNet IDM Desktop for
R/3 enters Advanced Interaction. For more information on advanced
interaction, refer to section Advanced Interaction FileNet Queue for R/3.

Late Archiving Using Bar Codes

While processing incoming documents using bar codes, you can:

e Attach a unique bar code to each incoming document before it is
distributed for processing.

o Book the paper document into SAP application and create a new SAP
transaction.

e Create a temporary link between the document and the SAP object.
To create this link, and the bar code into the SAP system. This link is
stored in SAP database.

e Retrieve the scanned document from a FileNet Workflow queue, and
send a message to SAP system containing the FileNet document ID
and bar code value.

e Create a permanent link between the SAP transaction and the
document, using SAP Object ID and FileNet document ID. To create
this link, match the message containing the FileNet document ID and
bar code value with the temporary record. This action is automatically
performed by cBarcode component, which is a part of the DWSAP
Server Components.

Using FileNet Queue For R/3

FileNet Queue for R/3 is one of the views shipped with FileNet IDM
Desktop for R/3. It allows the user to access the contents of a FileNet
Workflo queue that holds documents that are ready for processing in SAP
system.

Accessing FileNet Queue For R/3

In order to access FileNet Queue for R/3, open FileNet IDM Desktop for
R/3. Access the menu File > Open iview - FileNet Queue For R/3.

Menu And Command Summary

The following table briefly describes the menus and commands that
FileNet Queue For R/3 adds to the standard menus of the FileNet IDM
Desktop for R/3.

Queue Menu

The options on the Queue menu are:
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Using FileNet Queue For R/3

Option

Function

Fetch Next Document

If 'Auto Fetch' is off and all documents in
the list-view have been processed, the
user can choose this option to display the
next document(s) in the list-view. See
Fetching Documents from a Queue.

Auto Fetch

When ‘Auto-Fetch’ option is turned on
FileNet Queue For R/3 to automatically
fetch the next document when the
document in the list-view has been
processed. See Auto-Fetch

Pend Queue Entry...

Using this option the user can pend the
selected document for a certain number of
hours or days. See Pending Documents.

Skip Queue Entry

Using this option the user can skip a
document and make that document to go
to the end of the Workflo Queue. See
Skipping Documents

Reroute Queue Entry

Using this option the user can Reroute a
document, this means to remove it from
the current Queue and insert it at the end
of another Queue. For more information
refer to Rerouting Documents

Search

This menu item invokes the ’'Queue
Search’ dialog, which allows you to
execute a search on the contents of a
queue. See Searching a Queue

Configure Queues

This command invokes the ’'Configure
Queues’ dialog that allows configuring
Queues that is the user can add or remove
to the FileNet Queue For R/3 from different
Workspaces.

Continue Assignment

Lets the user to continue with the current
selection after starting advanced
interaction. For more information refer to
Advanced Interaction FileNet Queue for
R/3.

Cancel Assignment

Lets the wuser to cancel advanced
interaction. For more information refer to
Advanced Interaction FileNet Queue for
R/3.

Graphical User Interface

The FileNet queue for R/3 has a GUI similar to Microsoft Windows
Explorer. In the tree-view, the configured IS libraries are displayed. To
see the workspaces for a library, double-click that library, or click the
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expand symbol (+) next to the library. If you are not logged on to the
selected library, a logon dialog appears depending on the FileNet IDM
Desktop settings. Click the expand symbol (+) next to the workspace, to
see the Workflo Queues for the selected workspace.

Note: All Queues for the selected workspace will be displayed in FileNet
Queue for R/3’s tree view, even the queues without a DocumentNumber
field. However, while selecting such a queue, the user will be notified with
a message and the queue will be deleted from the tree view.

The right pane shows the contents of the selected queue in the tree view.
A queue can contain several documents simultaneously; but only one
queue entry will be displayed in the list view. The selected document will
automatically be displayed in the FileNet IDM Viewer.

The list view supports four different views that can be selected using the
list view’s context menu.

e Largeicons.
e Small icons.
e List.

e Details.

To display index values of the documents listed, select the option View
Details from the context menu of the list view. FileNet IDM Desktop for
R/3 uses the columns specified in Microsoft™ Windows Explorer for each
library.

Tip : To configure different columns to be displayed for a specific library, open a
FileNet library in Microsoft™ Windows Explorer and click Options in the context
menu of the list view pane.

Configuring Queues For Display In FileNet Queue For R/3

In order to configure queues for display in FileNet Queue for R/3, perform
the following steps.

1. Open FileNet Queue for R/3. The following screen is displayed:
B FileNet IDM Desktop For R/3 - [FileNek Queue =10 x|

2 Fle Queus  Window Help -7 x|
FileMet Meighborhood

%R Fil=MET Meighborhood

Contents

Ready.
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2. Access the menu Queue - Configure Queues. The following screen

is displayed.
im. Configure Queues ;IEIEI
— List of selected
izt of zelected queues ok
Cancel

fdd Eemowve |

To reflect the changes made in the gueue configuration, the Queue CIM will be reset after clicking the Ok
bttan.

3. Click Add .The following screen is displayed:

. Configure Queues x|
— Select the queue to add Ok
Library: A
Cancel
Wiorkzpace: I j
Hueue; I j

4. Select the Library, Workspace and Queue and click Ok. The following
screen is displayed:

i, Configure Queues ;IEIEI
— List of selected
ist of selected queues ok
Defaultik5:IMESERY:FleMET - Workspace] ueue] ;
Defaultlbd5:IMGSERY:FileMET - ‘Work S pace2 /Queus] Cancel

Add Bemaowve |

To reflect the changes: made in the gqueue configuration, the Queue Clk will be rezet after clicking the Ok
buittar.

5. Click Ok. The following screen is displayed:

March 2003 FileNet Document Warehouse for SAP 23



Document Processing Using FileNet IDM Desktop For R/3
Using FileNet Queue For R/3

B FileNet IDM Desktop For R,/3 - [FileNet Quet -|al x|

Eﬁ File Queus Window Help -|5’|5|

FileMet Meighborhood

Contents

g FileMET Meighborhood
=i IMGSERY
-] WorkSpacel
o ] Queuel
=] WaorkSpace?
o ] Queuel

Feady.

Fetching Documents From A Queue

When a Workflo Queue is selected from the tree-view of FileNet Queue
for R/3, the right pane displays a document. In order to fetch the next
available document the Fetch Next Document command on the Queue
menu can be used.

FileNet Queue for R/3 fetches the next available document from the
Workflow Queue, when:

Queue entry is not busy, which means it is not in use by a different user.
¢ Queue entry is not delayed.

¢ Queue entry is complete.

e Periority of the queue entry is in the range of 1 to 9.

e Oldest queue entry with the highest priority is fetched.

When a document is fetched from the queue, the queue entry is locked
until it is linked to an SAP object. After SAP has processed the document,
FileNet IDM Desktop for R/3 fetches the next document in the queue if
Auto-Fetch option is checked. Otherwise, Fetch Next Document
command from the Queue menu can be used to retrieve the next
document for processing.

Auto-Fetch

When Auto-Fetch option is checked, FileNet IDM Desktop for R/3
deletes the linked document, and fetches the next document from the
Workflo Queue.

When Auto-Fetch option is turned off, FileNet IDM Desktop for R/3 does
not fetch the next document automatically from the Workflo Queue after
linking with SAP. To retrieve the next document, select Fetch Next
Document option from the Queue menu.
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Pending Documents

A document in a queue can be marked for processing later. The FileNet
queue for R/3 returns the document to the queue, where it remains until
the specified period elapses.

Note: A pend document is unavailable for processing and does not
display as part of the queue contents. When the specified period elapses,
the document automatically becomes available for processing.

To pend a queue entry:

1. Click Queue - Pend Queue Entry menu. The Pend Queue Entry
dialog box appears, as shown in the figure below:

imi. FileMet IDM Desktop For R /3 - Pend Queue Enkr - |EI|1|

FPend Queue Entry

Ok

F —_—
Pend Queue Entry far I Hours

™ Days Cancel

2. Select the respective radio buttons to specify whether the document
be put on hold for Hours or Days.

3. In the Pend Queue Entry for text box, enter the number of days or
hours you want to pend the document.

4. Click Ok button to place the document on hold and return to the
FileNet IDM Desktop for R/3 window.

5. If Auto Fetch option is checked, the next document is fetched from
the Workflo Queue; otherwise, list view will be empty.

Skipping Documents

Skipping documents option can be used in case it is not required to
process the document in the queue immediately and make that document
go at the end of the Workflo Queue. The FileNet Queue For R/3 deletes
the document from the queue, and reinserts the document at the end of
the Workflo Queue.

To skip a document:
1. Click Queue - Skip Queue Entry menu.

2. If Auto Fetch option is checked, the next document is fetched from
the Workflo Queue; otherwise, list view will be empty.

Rerouting Documents

The user can also send a document to a different queue. The FileNet
Queue For R/3 deletes the document from its current queue, and inserts it
in the specified queue.
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To re-route a document:

1. Click Queue > Reroute Queue Entry menu. The Reroute queue
entry dialog box appears, as shown in the figure below:

im. FileMet IDM Desktop For R/3 - Reroute Que - |EI|£|
o Filter Queus On Document Mumber

— Select target guele
Ok

Library: |IMGSERY

Workspace Wwork S pace? j Cancel

Hueue: I j

2. Enable or Disable the Filter Queue On Document Number check
box.

3. If Filter Queue On Document Number check box is checked, only
those queues of the workspace are visible that have the
DocumentNumber field defined.

4. If Filter Queue On Document Number check box is not checked, all
gueues that belong to the selected Workspace are visible.

5. Select the destination queue to which the document is to be re-routed.
The user can select a Queue from different Workspace, but not from
another Library.

6. Click Ok button to reroute the document.

Searching A Queue

The Queue Search dialog box lets the user specify and execute a search
on the selected Queue. Click Queue - Search menu, to invoke the
Queue Search dialog box.

i, FileNet IDM Desktop For R/3 - Queue Search o ] |
Fetch incomplete queue entries?—————————  ~ Other restriction: _
ak
" Only incomplete entries Retrieve max. entries at a time |5U
% No incomplete entries P aximurn pricrity |5 Cancel |
" All entries, even if incomplete Minimurn pricrity IU
—Fetch busy queue enties?—————  ~Documents
" Only busy entries Dacumentld: I
% Mo busy entries
Al entries, even if busy

~Fetch delayed queue entriss?

[ &l entries, even if delayed

The various search options in the Queue Search dialog box are:

e Fetch incomplete queue entries.
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e Fetch busy queue entries.

o Fetch delayed queue entries.

¢ Retrieve max entries at a time; the default value being 50.
e Minimum and Maximum priority.

e Documentld.

Linking A Document To SAP R/3 Transaction

Prior to linking a document or folder to SAP R/3 transaction, a document
should be selected from the list view of FileNet Queue for R/3. The
selected document will be linked with SAP R/3 objects when SAPGUI
sends a request. If the linking finishes without an error, the document is
deleted from the Workflo Queue, and also, is removed from the list view
of FileNet Queue for R/3. If an error occurs, a message is shown and the
document is not deleted from the queue.

Advanced Interaction FileNet Queue For R/3

In some cases, a request from SAPGUI for a FileNet document id cannot
be immediately satisfied. Instead of directly returning an error indication to
SAP, the user is informed of the error and is given another chance to
come up with a valid selection. This process is called Advanced
Interaction.

Following are the examples of such cases.

Case 1: When a user tries to assign a document to an SAP object and
the currently active View cannot provide a document id (e.g. because no
document has been selected), SAPGUI displays an informational
message that no documents were scanned in.

X

FileMet IDM Desktop for R/3 - Browse

@ Before assigning a document vou need to select a document.,

You can now select a document and choose menu ikem 'Conkinue Assignment’, or you
can cancel the assignment via menu item '‘Cancel Assignment’ {producing an
informational error message in SAPQUI.

Case 2: If the user selects an object, but SAPGUI requests a document id
from a different library. In this case, the user is informed about it, and the
user is asked to make a new selection. The document id of the newly
selected document is returned to SAPGUI.
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FileMet IDM Desktop For R/3 - Queue 5'

@ The selected document '169699' belongs to library TMGSERY, but R3S requested a document: From library Frbuild',

You can now select a different document and choose menu item 'Continue Assignment’, or you can cancel the
assignment wia menu ikem 'Cancel Assignment’ (produding an informational error message in SAPgUI).

Using FileNet Browse For R/3

FileNet Browse for R/3 is one of the views shipped with FileNet IDM
Desktop for R/3. It allows browsing through Image Services (IS) and
Content Services (CS) Libraries. It also allows selecting documents and
folders to link to SAP R/3 transaction. The following figure shows the user
interface for FileNet Browse for R/3:

£ FileNet IDM Desktop For R;/3 - [FileNet Browse For =0 =|
2 Fle Browse Dms Window Help 7] x|
IFileMet Meighborhood Contents of 'HR'

i IMGSERY a| | #)179807

- Accounts

-] Administration

-] Finance

=1

&[] Hospital

&[0 Marketing

-1 Medical -

T . e

Feady.

Menu And Command Summary

The following table briefly describes the menus and commands the
FileNet Browse For R/3 adds to the standard menus of the FileNet IDM
Desktop for R/3.

Browse Menu

The options on the Browse menu are:

Option Function

Search Lets you specify a search by opening the
search dialog. See Searching Documents

Switch to View ... Lets you choose whether Documents or
Versions are displayed in the List View.

See Working with document versions

Continue Assignment Lets you continue with the current selection
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Option Function

after starting advanced interaction.

See Advanced Interaction FileNet Browse
For R/3.

Cancel Assignment Lets you cancel current assignment.

See Advanced Interaction FileNet Browse
For R/3.

Graphical User Interface

The FileNet Browse for R/3 has a Graphic User Interface (GUI) similar to
Microsoft Windows Explorer. In the tree-view, all the configured IS
libraries are displayed. If smartlds are enabled, then all the CS libraries
are also displayed.

To see the top-level folders, double- click a library or click on the expand
symbol (+) next to the library. A logon dialog will appear. After the user
has logged on, the right pane, which is the list view, shows the contents
of the currently selected library or a folder from the tree view. After
selecting a document, the document will be displayed in the FileNet IDM
viewer.

The list view supports four different views, each of which can be
accessed via the list view’s context menu. To display index values of the
documents listed change to ‘View Details’. The list view will then display
several columns, each column representing a document index.

FileNet IDM Desktop for R/3 uses the columns specified in Microsoft™
Windows Explorer for each library.

Tip: To configure different columns to be displayed for a specific library, open a
FileNet library in Microsoft™ Windows Explorer and click Options in the context
menu of the list view pane.

Linking A Document, A Version Or A Folder

Prior to linking a document, a specific version or a folder to SAP R/3
transaction, a document, version or folder should be selected. The
selected object is linked to SAP. If the linking finishes without an error, the
object is deselected.

If more than one document, version, or folder is selected, the top-most
selected object is linked. Subsequent to successful linking, the next top-
most selected object is displayed in the FileNet IDM Viewer and this
object is the next object to be linked.

Using SmartiDs

Using FileNet IDM for R/3 configuration tool, the user can enable or
disable the use of SmartID. In Configuration Tool, go To Client >
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General section, enable or disable SmartlDs option in the Type of
document ids frame as shown below.

A2 Document Warehouse for SAP Configuration ] -4
File Edit Help
ZIODE 3@
El- Common
=- Client —Active Sap System
i General 5
Active Sap Syztem FH1 -
Bl iews I J
- Dmg — Type of document ids created
" Conventional document ids
—H "

— AutoLagon
I~ Enable automatic lagon [ Automatic Logaff after I 0 Minutes

— Default Digplay Connector
DM Wiewer

= Internet Explarer

" Cugtom I

1D Yiewer

M awirnurn Docurmerts |1 0

r Filter Queus Setting

I Filter Queue D Docurnent Murnber

Note: If SmartiDs option is not enabled, user will not be able to link to a
folder. The Content Service libraries will not be displayed in FileNet
Browse For R/3.

Working With Document Versions

Content Services (CS) keeps track of the versions of its documents. User
can access a document, which refers to the latest version of the
document, or can specify a version of the document to be accessed.
DWSAP allows linking a document or a specific version of a document to
an SAP R/3 transaction.

To enable version linking, switch the list view to view the versions of the
documents via menu item Browse - Switch to View Versions, as
shown in the figure below:
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E@ FileMet IDM Desktop For R /3 - [FileMet Browse For R3] - |I:I|£|

EEFHE Browse [ms  Window Help — |7 x|

IFiIeN et M Search... Contentz of ‘@dmin’

& File Switch bo Wiew Versions @abc

ﬁ E @Cnmpnnd
Eﬁ 0 Conbinue Assignient DuwDefaulk, 200301351
B0 Cancel Assinment DwDefault, 20030206

-1 Adrministration
|:| ZompanyPolicies
Cl D3_Docurnents
-] Finance
D HR

I:l Parketing
I:l Medical

[:l Research
CI Swskem

- frbuild

g IMESERY

R eady.

The list view will then display one item for each version. If a version of a
document is selected, the status bar indicates this by adding the version
number to the document id, such as 003682577:3.

E.' FileMet IDM Desktop For R /3 - [FileMet Browse For R3] -0l x|
Eﬁ File Browse Dms ‘Window Help =8| x|
lFiIeN et Meighborhood Contents of ‘Admin’
ﬁ FileMET Meighborbood Ikem | Version 1D |
-y Entire FileNET Network 36 abc 1
Eﬁ csdh Fabe | 2
|:| Accounts IE;H';;:and 1
a Adrin D3Document 1
D Adminiskration e o p—— 2
|:| CompanyPolicies D3Document 3
I:I D3_Decuments Dabocument 4
-1 Finance
D HR
|:| Marketing
-2 Medical
-1 Research
|:| Syskem
- Frbuild
-l IMESERY
Ready.

To switch back to document view, click Browse - Switch to View
Documents menu. The list view will then display one item for each
document.
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Advanced Interaction FileNet Browse For R/3

Advanced Interaction as implemented in FileNet Browse For R/3. is
similar to FileNet Queue For R/3.

If no document is selected when SAPGUI sends a link request, for an
assignment, a message is displayed, as shown in the figure below:

FileMet IDM Desktop for R/3 - Browse 5[
@ Before assigning a document vou need to select a document,
You can now select a document and choose menu ikem 'Conkinue Assignment’, or you

can cancel the assignment via menu item 'Cancel Assignment’ {producing an
informational error message in SAPQUI.

FileNet IDM Desktop for R/3 waits for the user to select either of the
following two options:

o Cancel Assignment: User chooses not to select anything and cancel
the current assignment by selecting menu item Browse - Cancel
Assignment.

e Continue Assignment: User can select a document or folder and then
proceed with the current assignment by selecting the menu item
Browse - Continue Assignment.

Searching Documents

A search can be performed on a library on the basis of some
characteristics of the documents. To search the documents within the
FileNet library:

User can perform search by selecting the search menu item through
Browse > Search. This opens the search dialog. The search dialog has
the following two views:

e Advanced Query .
e Simple Query.

By default, the Advanced Query view is shown. The following screen
shows the Advanced Query view:
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i, FileMet IDM Desktop For R /3 - Search x|
Criteria I Results Options |
. Mew Search |
Look i |igf 1MaSERY RN
o 2 el ) S e o =2 = SeachNow |
Key Condition Cperator Walue | Count Oriy |
= Simple Quem |
Property Operatar Walue s
Close |
|Last Count: -~
The following screen shows the Simple Query view:
i, FileMet IDM Desktop For R /3 - Search ﬂ
Document (D e asimum retumed:
I j I-I oo i’ Mew Search |
Document Class:
I j Search How |
Added between: Loak it Count Only |
| | sERy =
o Advanced Query I
I Browse... ™ Include subfalders
Cloze |
|Last Count; -
Specify A Search

In both the search views, choose the appropriate library from the drop
down field. After logging on to the library further search criteria should be
entered.

Count The Number Of Documents Matching Search Criteria

To count the number of documents that match the search criteria, click
Count Only button after specifying the search criteria. The number of
documents that match the search criteria are counted and the result is
displayed in the Last Count box in lower right corner.

March 2003 FileNet Document Warehouse for SAP 33



Document Processing Using FileNet IDM Desktop For R/3
Using FileNet Browse For R/3

&, FileNet IDM Desktop For B3 - search il
Diocument 10 M arimum returned:
I j I-I oo ::I Mew Search |
Document Class:
[sePaLFDC =l Sieanchn oy |
Added between: Look ir: Coirat Only |
[ | asERy =
and Advanced Query I
I Browse. . ™ Include subfolders
Cloze |
|Last Count: -

Display A List Of Documents Matching The Search Criteria

To list all documents matching search criteria, click the Search Now
button. The search dialog closes and the result is listed in the list-view
pane of FileNet Browse For R/3, as shown in the figure below:

E- FileMet IDM Desktop For R /3 - [FileMet Browse For R3] - |EI|£|
Eﬂ File Browse Dms Window Help - |E’ |£|
lFiIeNet M eighborhood [uern Resultz
& FileMET Meighborhood Item I -
ﬁ Entire FileMET Metwiork, E 190326
-l csdb T 190327 |
'ﬁ Frbwild E 190525
=l IMGSERY 130330
(] Accounks = 190331
[E3R ko, drinistr ation = 130332
=30
(2] Finance T190333
oG HR T 190334
I:l Hospital T1o0azs
-] Marketing 190336
-1 Medical 190337
-] ParentFolder T 190338
I:l ResearchDeviopment ﬂ 130339
-] Systems T 190340
T 190341 |
Fieady.

Specify A New Search

To clear the existing search criteria and specify a new search, click the
New Search button. The search dialog is cleared of the search criteria
and new criteria can be specified.
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DMS Enhancements To FileNet Browse for R/3.

DMS Menu

DWSAP provides DMS components for the following DMS functionality:

Creating and modifying DIRs in SAP R/3.

Linking objects from FileNet repositories such as document, specific
version of a document, folder, and stored search to DIRs.

Accessing information of SAP R/3 master records.

Functions for to searching and selecting SAP R/3 master records.

Option Function
Publish document to | Lets you create new DIR in SAP and link it
SAP R/3 to the selected FileNet object.
See Publish Document to SAP R/3.
Publish current | Lets you create a new version of a DIR in
document version to | SAP R/3 if View versions is enabled. In
SAP R/3 case, View documents is enabled, then
this performs the same function as publish
document to SAP R/3.
See Publish current document version to
SAP R/3.
Change Document | Lets you change the status of the DIR linked

status in SAP R/3

to selected FileNet object.
See Change document status in SAP R/3

Link to Material Master

Lets you search for material master records
in SAP R/3 and link the selected material
master to the selected FileNet object.

See Link to Material Master.

Display Material Master

Displays the material master records linked
to the selected FileNet object.

See Display Material Master

Unlink from SAP R/3
objects

Checks for all the DIRs linked to the
selected FileNet object and delete all the
links. See Unlink from SAP R/3 objects

Switch SAP R/3 system

Allows the user to logon to a different SAP
system. See Switch SAP R/3 System

Using The DMS Components

FileNet Browse for R/3 has been enhanced, with a new DMS menu that
allows the users to access the DMS functionality. This module allows
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selecting a FileNet object and linking it to a DIR and a material master
record in SAP. The following screen shows the DMS menu:

Er; FileMet IDM Desktop For R /3 - [FileMet Browse For R3] - |EI|1|
2 File  Browse | Dms Window Help -2 x|

IFiIeNet Meighborko  Publish document to S&P B3

W Publish current document version bo SAF B3 |
D Pfamell  Change document status in SAP Y3
&[] Admini:
I:l Financ
a HR

Link ko Material Master
Display Material Master

D Haspits  Lnlink From S&F R{3 objects

- Market

H-(E3 Medica  Switch SAF RS system
Ready.

The DMS menu offers the following functions:

e Publish document to SAP R/3.

e Publish current document version to SAP R/3.
e Change document status in SAP R/3.

e Link to Material Master.

e Display Material Master.

e Unlink from SAP R/3 objects.

o Switch SAP R/3 System.

Publish Document To SAP R/3

The publish document to SAP R/3 object links the selected FileNet object
to a SAP DIR object. In order to execute this function, follow the steps
below:

1. Click on the menu item DMS - Publish document to SAP R/3. In
case in the configuration tool the option Prompt for DIR Status and
Description is enabled in Client > DMS , a dialog box is popped. If
the option is disabled in Configuration tool , then skip to step4.

. Update DIR Description and Initial Status |

IDefauIt DIR

DIR Description

Initial Statuz I FE Released j Cancel |

2. The dialog box has the default values same as that configured using
the configuration tool. Enter the value for DIR description and select
the status of DIR to be created.
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3. If DIR with the default status and description is to be created, then
press Cancel. Otherwise, if the DIR is to be created with the new
parameters, then press OKk.

4. A new DIR is created and is displayed in the status bar as shown
below.

¥ FileNet IDM Desktop For R /3 - [FileNet Bro =10 x|

Eﬂﬁile Browse Dms  Window Help -|5’|5|

IFiletlet Meighbarhood Contents af ‘Aocounts’

B IMGSERY | [ E1e0a1z
a Accounts %190913

[+ Adrministration W 191650
D Finance
-] Hr
Hospital
Marketing
Medical

ParentFalder

-+

[#

-+

[#

[#

-] ResearchDevlopment
-] Systems

-

DIR DRW-0000000000000070000002113-000-00 created.

Publish Current Document Version To SAP R/3

The behavior of this function depends on whether display of versions is
enabled or not. The display of versions can be enabled through the menu
item Browse > Display versions. To disable display of versions for a
document, this option should be set to display documents. This can be
achieved through the menu item Browse -> Display Documents. In
case version display is disabled and view is set to display documents,
then publish current document version works in the same fashion as
Publish document to SAP R/3. In case, versions are displayed, then the
system checks whether any former version of the selected document was
linked to a DIR. If a DIR linked with a former version is found, then the
version of the DIR is incremented by one and linked to the selected
version object.

In order to publish current document version to SAP R/3, follow the steps
below:

1. Click on the menu item DMS - Publish current document version
to SAP R/3. In case in the configuration tool the option Prompt for
DIR Status and Description is enabled in Client > DMS , a dialog box
is popped. If the option is disabled in Configuration tool , then skip to
step4.
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. Update DIR Description and Initial Status |

IDefauIt DIR R

DIR Description

Initial Statuz I FE Released j Cancel |

2. The dialog box has the default values same as that configured. Enter
the value for DIR description and select the status of DIR to be
created.

3. If DIR with the default status and description is to be created, then
press cancel. Otherwise, if the DIR is to be created with the new
parameters, then press OKk.

4. A new version for a DIR is created and is displayed in the status bar
as shown below.

E‘; FileMet IDM Desktop For R /3 - [FileNet Browse For R3] - |EI|£|
ﬁ File Browse Dms ‘Window Help - |5'|5|
lFiIeNet M eighborhood Contents of Admin'
ﬁ FileMET Meighborhood Item | Yersion ID |
-4y Entire FileMET Network 6 abe 2
E"ﬁ csdb @al:u: 1
-] Accounts ] Compond i
a Adnir @ D30ocument 4
-] Administration & DaDacument 3
-] CompanyPolicies [ D3Document 5
-0 D3_Documents
|:| Finance D3Dacument 1
-1 HR E Test 3
-] Marketing E JEEE Z
-] Medical =] Test 1
(] Research
-] Swstem
- Fribuild
g IMESERY
Linked zelected object to Dir ‘TR -000000000000007 00000021 29-000-07",

Change Document Status In SAP R/3

This function allows changing the status of DIRs linked to the selected
FileNet object. To execute this function, follow the steps below:

1. Click on the menu item DMS - Change document status in SAP
R/3. A dialog box is displayed which shows all the DIRs linked to
selected FileNet object along with its current status and list of new
statuses as shown below:
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]
Select SAP R43 Document Curent Status
1 g IFH Releazed
DH 0000000000000 Q0000071 928-000-00
DR -000000000000007 0000001 925-000-00 Mew Status
AR Archived -
[, [ work,
FR Checked
SP Locked hd
Ok
Cancel

In the above dialog, select the DIR for which status is to be changed.

On selecting a DIR, the current status and new status are displayed
for the selected DIR.

4. Select the new status for the selected DIR and press Ok. This
changes the status of the DIR to the selected status.

Link To Material Master

This function allows searching for material master records and linking the
selected material master to the selected FileNet object. To execute this
function, follow the steps below:

1. Click on the menu item DMS - Link to Material Master In case in
the configuration tool the option Prompt for DIR Status and
Description is enabled in Client > DMS , a dialog box is popped. If
the option is disabled in Configuration tool, then skip to step 3.

isj. Update DIR Description and Initial SEatus x|

|Default DIR

DIR Dezcription

Initial Statuz I FE Released j Cancel |

2. If DIR with the default status and description is to be created, then
press Cancel. Otherwise, if the DIR is to be created with the new
parameters, then press Ok. The following screen is displayed:
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B2 Search for Material Master x|
Search criteria
hdaterial 1D ||
Search
taterial description |
b aterial (D | bd aterial Dezcription
] 4
Cancel

3. In the above dialog, enter the material Id or material description as
search criteria and press search button. A list of available material
master records is displayed as shown:

EZ search for Material Master x|

Search critenia

baterial 1D |m-|:|x
Search |

baterial description |

| kd aterial D ezcription

Suniy Sunny 07 - Test
Sunny =al

Sunry T etral3

Sunry Extreme Test
Flatzcreen LE GO P
Flatzcreen M5 1460 P
Flatzcreen LE B4P
Flatzcreen b5 1575F 0F.
Flatzcreen M5 1585

Cancel

4. Select a material master record that is to be linked and click Ok to link
this master record to the selected FileNet Object.

March 2003 FileNet Document Warehouse for SAP 40



Document Processing Using FileNet IDM Desktop For R/3
DMS Enhancements To FileNet Browse for R/3.

5. Anew DIR is created and is displayed in the status bar as shown

below.
E; FileMet IDM Desktop For R /3 - [FileNek Browse For R/3 - |EI|1|
ﬁ File Browse Dms Window Help - |5’ |5|
{Fileret Meighbarhood Contents of 'RezearchDevioprment'
B-fi csdb || 2] 190916
—ﬁ Fribwild ﬁ 190915
E--ﬁ IMGSERY &1 190920

D Accounts

-] Administration

I:l Finance

D HR

I:l Hospital

I:l Marketing

-] Medical

(L] ParentFolder

a ResearchDevlopment

I:l Syskems —

-

DIR DRw-0000000000000071 000000217 4-000-00 created.

Display Material Master

This function searches for all the material masters linked to the selected
FileNet object. In order to execute this function, follow the steps below:

1. Click on the menu item DMS - Display Material Master. This
searches for all the material masters linked to the selected FileNet
object. If the selected FileNet object is linked to more than one
material master, a dialog is displayed showing all the linked material

master.
4= Select Material Master x|

[b4-05
b-09
MS5A-1003

k. Cancel

2. In the above dialog, select the material Id for which details are to be
displayed and press Ok. This displays the detailed information for
Material Id in a new dialog box as shown below:
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x4
— Material
Material IMSAJ 00z ISIide filrm L 100 £52 24 exposures biw

— General Data

Mcse Categony IIZIEIZI— Division I1B—
Old baterial MNo. I— Froduct Hierachy Im
Unit of measure IST—
Lah./Office [

Unlink From SAP R/3 Object

This function checks whether the selected FileNet object is linked to any
DIRs and removes all links. To execute this function, follow the steps
below:

1. Click on the menu item DMS - Unlink from SAP R/3 objects. The
following message box is displayed which asks for user confirmation
for deleting all links.

IdmForR3Browse |

@ The FileMet Objeck '190918" is linked to ‘27" SAP RJ3 Object(s).Do wou wank to Delete all links?

2. Press Yes to remove all the DIRs linked to the selected FileNet
object. The status of the links being removed is displayed in the status
bar.

Switch SAP R/3 System

If this function is invoked, the following logon screen is displayed and the
user is able to logon to a different SAP system. All used SAP systems
need to be configured using the configuration tool.
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SAP Logon at Fnl |

—zer Data [k
LClient IEEIEI E.;m:el |
User [BAS515

Pazzword || 5
Syztem
Language IEN

d

Fazzword

Using FileNet Capture For R/3

FileNet Capture for R/3 is one of the views shipped with FileNet IDM
Desktop for R/3. It allows scanning and committing of paper documents
and linking these paper documents to transactions in SAP R/3.

Using FileNet Capture for R/3, paper sheets are scanned and the
scanned pages are assembled to documents. These documents can be
committed to Image Services (IS) libraries. The committed document can
then be linked to an SAP transaction. It is not possible to commit or
assign more than one document in one step. The following figure shows
the user interface for FileNet Capture for R/3:

E‘; FileMet IDM Desktop For R /3 - [FileNek Capture for B3] - |I:I|5|
2 Fle  Capture Window Help -7 x|

IFiIeNET Meighborhood |S canned images

ﬁ FileMET Neighborhood [ 1o Pl
-y Entire FileMET Netwaork
i IMGSERY

a &ccounts

I:I Adrnin

I:I Adrninistration

I:I Markeking

-] Medical

Selected item: 'Page 184051

Menu And Command Summary

The following table briefly describes the menus and commands the
FileNet Capture for R/3 adds to the standard menus of the FileNet IDM
Desktop for R/3.
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Capture Menu

The options on the Capture menu are:

Option

Function

Scan

Lets you scan in pages. See Scanning a
document.

Cancel session

Deletes the scanned in pages and starts a
new session.

Continue Assignment

Lets you continue with the current
selection after  starting  advanced
interaction. See Advanced Interaction
FileNet Capture For R/3.

Cancel Assignment

Lets you cancel advanced interaction.
See Advanced Interaction  FileNet

Capture For R/3.

Options...

Opens the options dialog. See
Configuring FileNet Capture for R/3.

Selecting A Library And Logging On

The Graphic User Interface (GUI) of FileNet Capture For R/3 allows to
select the IS Library to which a document has to be scanned and
committed. Before scanning any paper documents, the user should select
and logon to a library by selecting a library from the tree view. If the user
has not logged in then, a logon dialog appears for login credentials.

Configuring FileNet Capture for R/3

FileNet Capture for R/3 needs to be configured before it can be used. To
configure FileNet Capture for R/3, click Capture - Options menu as

shown.
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¥ FileNet IDM Desktop For R;/3 - [FileNet Capture fo =10 x|
Eﬂ File | Capture ‘Window Help =& x|
lFiIeNET [ Scan I
h E Cancel session T
= I Zontinue assignmemnt:
""" 4 Cancell assianment
g
E Cpkions ...
inance
A Hr
I:I Hospital
I:I Marketing
I:I Medical
-[7] ParentFolder
-1 ResearchDevlopment
(7] Swstems |
-
Ready.

The options dialog is displayed as shown below.

i, Library settings il
— Configuration for: 'IMESERY!

Current zettings I Setting_[kMG j

Cancel |

SAFT ype defaulk value IF.-'l'-X

In the options dialog, the following settings need to be configured:

e Current Settings: refers to the Capture settings to be used for the
selected library. The Capture settings specify the document class to
which the document is to be committed. It also specifies the settings
for scanner, assembly, indexing and other capture components. For
information on configuring settings in Capture, refer to Installation &
Configuration Manual -Client.

e SapType default value: refers to the default value of the document
index SapType. For scanned documents, this is usually FAX.

Note: The document class must contain an index SAPType. For
information on DWSAP conform document classes, refer to FileNet
DWSARP Installation & Configuration Manual — Server.

Scanning A Document

To start scanning after logging on to a library, click Capture - Scan
menu, as shown in the figure below.
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E-' FileMet IDM Desktop For R /3 - [FileMet Capture ;IE'EI
Eﬂ File | Capture Window Help IR
EEL |

Cance] session '
E‘ﬁ I continue assignment
Camzel assigmment

- Options ...

Ll Finance

- HR:

(-1 Hospital

-1 Marketing

-1 Medical

-] ParentFalder

I:l ResearchDevlopment

-0 Systems L |

Ready.

Note: The scan session is not initialized, when the user double-clicks a
library. User has to single click on the label of the library, or logging on via
the library's context menu to select the library. The Scan menu item will
be disabled as long as the scan session is not initialized. After having
started scanning the user cannot change the current library, until the scan
session is cancelled or the document has been committed.

Depending on the scanner and driver used, the user will be prompted for
various actions, if necessary. For example, user might be asked to insert
paper or to press a specific button on the scanner. The scanned pages
are displayed in the list view of FileNet Capture For R/3. When the user
selects a page in the list view, it is displayed in the FileNet IDM Viewer.

Different Views In The List View

Scanned pages are displayed in the list view of FileNet Capture for R/3.
The user can change the way the pages are displayed in the list view
using the context menu item View of the list view. The different options
available with this menu item are:

e Thumbnail: The pages are displayed as thumbnails

e Small Icon: Each page is represented by a symbol and the page’s
name

e List: The pages are displayed in a list format.

o Details: The pages are displayed in a list format, with additional
information about each page in several columns.
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Er; FileMet IDM Desktop For R /3 - [FileMek Capture for R3]
Eﬁ File Capture ‘Window Help

=10l x|
=18 x|

IFiIeNET M eighbarhood

ﬁ FileMET Meighborbood
+-Qy Entire FileMET Metwork
- IMGSERY

423 Accounts

[:l Adrnin

[:l Adrninistration

[:l Marketing

[:l Medical

[Scanned images

Copy itemis)

Paste itemis)
Delete itemis)
Zut itemis)

Thurmbnails

Small icons

Dietails

Selected itern: 'Page 184051

The following actions are available for documents displayed in the list

view:

o Delete: The selected pages are deleted and the user cannot revert

back deletion.

o Copy: The selected pages are copied to the clipboard.

e Cut: The selected pages are moved from the list view to the clipboard.

¢ Insert: The contents of the clipboard are appended to the list of pages
in the list view. User can change the sequence of pages within the
document by dragging and dropping the pages in the list view pane.
The dragged page is inserted right after the page dropped to.

Linking A Document

Prior to linking a document or folder to an SAP transaction, the user
should scan at least one page. All the pages of the current scan session
are then assembled into one document. This document is committed to
the selected library. This document can be linked to an SAP R/3

transaction

If the linking finishes without any error, the scan session is closed and the
list view is cleared. If any error occurs, the user is informed and the
scanned pages remain in their batch. The list view is not cleared.

Advanced Interaction FileNet Capture For R/3

Advanced Interaction as implemented in FileNet Capture For R/3. is
similar to FileNet Queue For R/3.
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Document And Data Archiving

FileNet DWSAP application archives documents generated by SAP, to
FileNet. These documents are called outgoing documents. This chapter
describes the synchronous and asynchronous archiving of outgoing
documents generated by SAP.

Archiving Modes

DWSAP supports both synchronous and asynchronous archiving of
outgoing documents generated by SAP R/3.

e Synchronous archiving refers to the process in which an archiving
request is sent directly from SAP to DWSAP server components
which process the request and sends the response back to SAP. SAP
waits for the response from DWSAP. If the request is processes
successfully, the FileNet document Id is returned in an
acknowledgement message.

e Asynchronous archiving refers to the process in which the archiving
requests are sent to DWSAP server components which sends an
acknowledgement immediately. The request is processed later and
the FileNet document Id is returned in a separate confirmation
message.

Archiving Outgoing Documents

While configuring output, the user must first verify that the definitions exist
in the Global Document Type list and in the Links list. For information on
these configuration steps, refer to FileNet Installation and Configuration
Manual —Server.

The following tables list examples of the documented output types that
SAP indicates are achievable as of the 4.6¢c release. For details, refer to
the SAP documentation.

Material Management Purchasing Documents (MM - PUR)

Description Document SAP
Type Business
Object Type
Outline agreement MEOAGREEM EKKO
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Purchase order (PO)

MEOORDER EKKO

Request for quotation (RFQ)

MEOREQUOTE | EKKO

Delivery schedule (issued under a
scheduling agreement)

MEOSCHEDUL | EKKO

Reminder/expediter re: ordered

goods

MEOREMIND EKKO

Acknowledgment expediter

MEOACKNOWL | EKKO

Sales and Distribution (SD)

Description Document SAP Business Object
Type Type
Sales activities SDOACTIV VBKA
Quotation SDOQUOTAT VBAK
Order confirmation | SDOORDER VBAK
Delivery schedule | SDODELPLAN | VBAK
Picking list SDOPICKLIS LIKP
CMR Bill of lading | SDOCMRBOL VTTK
Foreign trade data | Rebate  credit | VTTK
memo
Delivery note SDODELNOTE | LIKP
Invoice (cash sale) | SDOINVOICE VBAK
Invoice list SDOINVLIST VBRK
Rebate credit | SDOBONUS VBAK
memo
Plant Maintenance (PM)
Description Document SAP Business Object
Type Type
Maintenance PMONOTFPAP BUS2038
notification
Service notification PMOSERVPAP BUS2080
Maintenance order PMOWORKPAP BUS2007
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Quality Management (QM)

Description Document SAP Business
Type Object Type

Complaints field by QMOLETTER1 BUS2078

customers

Complaints against QMOLETTER2 BUS2078

vendors

Internal problem QMOLETTERS BUS2078

notifications

Module Specific Settings

Once the Global Document Class is created, it must be assigned to the
Output Type. Configuration steps for each module can vary. For more
information, refer to SAP documentation.

Note: SAP documentation provides valuable information about optical
archiving of incoming and outgoing documents, data, and print lists.

Archiving Print Lists

SAP R/3 has the ability to create a Printlist from SAP R/3 database. SAP
R/3 creates this printlist and stores it in a temporary location. This printlist
is stored onto FileNet IS via DWSAP. Follow the procedure below to
generate a printlist and send the archiving request to DWSAP:

1. Start SAPGUI, logon to an SAP System and go to transaction sa38.
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2l a0 BECOQIDHE Bt La8IRE Q6
ABAP Editor: Initial Screen

m | | |@u Dehugging ||® Excecute with variant ||& Variants|

RFBEL.JAD (@ [0 create |

Subobjects

@ Source code
O variants

O Atributes
) Documentation
) Test elements

|6%¢ Display | L? Change

2. Use the program name as RFBELJ00 and Execute or press F8 key.
The following screen is displayed:

il

gl @ 5JB@ @@ D i
Compact Document Journal

General selections

Posting date [1.18.1999 10.10.1939
Reference number

Technical settings
[ Readitems sequentially

Diata sources
\@ Choose data sources
Diata source(s) Datahase

Archive selection

Further selections !

Standard documents
Parked documents
[] statistical documents

[] Sample documents
[] Recurting entry atiginal docs

Output contral

[ oOnly display totals

> [5A38 1= metsan
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Note: RFBELJOO is one of the many reports in Financial Accounting (FI)
supported by Archivelink interface. For details of different object types
and document types supported by ArchiveLink, refer to the SAP R/3
online documentation.

3. Enter the selection criteria. Generate the printlist by pressing Execute
or F8 key.

4. A Compound Document Journal is displayed. This is the content of
the Printlist.

Note: There are two ways to generate printlists — in the foreground or in
the background. Foreground generated printlists do not create an Index
file that gets stored when it is archived. Background generated printlists
create an Index file that is stored when it is archived. Printlists searching
can only be performed on printlists that were generated in the
background. To create and archive the printlists in the background, the
Optical Archiving box must be checked.

i »
g Print 2d H@E@ CRE Dhasa E
Save 3
I nt Journal
Exit Shift+F3
IDES A0 Compact Document Journal E‘
Franktfurt E
Document header Subledger accounts Taxes |
Caold Document Do Posting b Account Fostn Open item amount Tx Tax on s1s/pur.
numher Ty date T numher Ky L in DEM (FC) [ad amount. in DEM
1000 160000723 DA 01.10.1999 (0 OAEQEO3450 01 £,900 .60 |81 800 .008-
Reference: HO0OO013200AMYS0|D BREOAO3450 B9 F34.76 |M 69.75-
[ ARAEAO3450 149K h34 . 75- | 42 Th-
[ BREEAO3450 £9. 327. 75
[ BOAEAO3450 19K 327.75-
1000 160000724 DA B1.10.1999 (0 BDEOREO3453 01 6,969 600 |81 909.008-
Reference: AE0OE013200AMYS0|D OARAO3453 B9 414 60 |41 f4 HA-
[ OOEEAO3453 19K 414 .80- |41 T.50-
[ BEEEAO3453 B9 57.580
[ ORAEAO3453 149K 57 . 50-
1000 1600BEAT25 DA @1.10.1999 (0 AAAAEO3454 01 7 A47R B |8 975 .00- E‘
Reference: AE00E01 3200AMYS0|D OOAOAO3454 B9 460 .60 |81 BB . OA- E
(el [ |[«][+]

| [ | 5438 b metsap OVR o

5. Archive the displayed printlist by choosing the command List - Print
under the list option. The following screen is displayed:
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H @G 2 EE S0 4aE8EE G Y

Print Screen List

| Continue || User-gpecific print parameters |

Mumber of pages
@ Print all
) Printfram page

Spool request

MNarme RFBELJBO_EAS
Title
Autharization

Spool options
1 Printimmediately

[] Delete after output
Mews sponl request

[ SAP cover page

D OperSys cover page

Print priority 5 Medium [] Selection cover page
Retention petiod 8 Day(s) Recipient BASIS
Archiving mode Print anly e Department hasis
I [> | 5a38 sl metsap | INS

6. Enter the following parameters for the print job and press the Print or
Enter button.

o OQutput Device: Printer defined on the SAP system (the ARCH
output device does not display in this list).

o Title: Text description of the print job.
e Print immediately: Select this option to force immediate printing.

o Delete After Print: Select this option to delete the document from
the work list after archiving/printing.

e Archiving Mode: Determines the output of a Printlist. It can have
values Archive Only, Print Only and Print and Archive.

The following screen is displayed:
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Archive parameters

Ohj. trpe
Dioc type

|

Incoming invoice

Additional information

Information
Text

Date

User
QutputDevice
Format

RFEELJOA K

18.02 . 2003
BASIS

BT Frinter
i_BA_132

[l

K1Y

Archive | 38

7. Complete the following parameters:

e Object Type: Object Type defined in SAP R/3. The object type
determines the link table where the printlist is indexed and
determines the archive where the document is stored.

e Document Type: Type of document defined in SAP R/3. The
object type determines the link table where the printlist is indexed
and determines the archive where the document is stored.

e Information: Any information that can be used to identify the

Printlist easily.

o Text: Text description of the printlist. This description displays as
an attribute on the resulting output request.

8. Press the Archive or Enter button. The following screen is displayed:
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After job At operation mode

After joh At operation mode

o o B %

9. Enter the start time for the background job. Press the Immediate and
Save buttons to execute the job immediately. This will start the
process of generating the output file.

10. A message is displayed in the status line indicating that a background
job has been generated.

11. Depending on the size of the Printlist, generating the printlist can take
some time. The status of the job can be checked by choosing Own
jobs from the System menu.

12. Asynchronous archiving, which is used for archiving Printlists, is
usually scheduled only once a day in the off-peak operating hours. In
order to archive the printlist immediately, an archive request must be
triggered.

13. Go to transaction oam1. The following screen is displayed:
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& JHICOQ SHB Do IR
SAF ArchiveLink: Monitor

L=y

Asynchronous requests Background processing

Caonsiderwhen refreshing
Considerwhen refreshing
(& open |ITE B
& Scheduling
S  Store

Congsiderwhen refreshing & Confirmation

Retrieve
| 251018

Bar codes

Considerwhen refreshing

S Storage g El! S Intrnl
dyr Confirmation :Ed i Extrrl
S Retrigve

Logging
Connection test

[] considerwhen rafreshing Cohsider when refrashing

8343

FM1 (2) (a00) [l | metsap | OVR

14. In the Queues Group Box, click the Storage button. A list of open
requests referenced by spool request number will be displayed.
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List Edit

Goto  Settings  Systemn

2 dH e SRR BN
Queue: Content server (CARA)
S daYEEEFYFTEAD

Help

[+]
Unit|Lon YWersion|ReferenceFlan E‘
L 4 | DWRFC 0e31 000AAZ25A04_AA001
C 5 | DWRFG 2031 000AB25005_AAAE1
C 6 |DWRFG 2031 0000825101_AAA01
C 7 | DWRFC 0o31 000AAZ5601_AA001
C g |DuopP 2045 Q00AB25603_Aaaa1
C 9 | DWRFG 2031 000AB25608_AAA0
C 10 | ALYIEWER| 8031 000AAZ24912_@A001
C 11 | ALYIEWER|BO31 000AAZ24920_AA001
C 12 | ALYIEWER | 8031 000AB24921_AAA01
C 13 | DWRFE 2031 000AB24903_AAA01
C 14 | DWRFE 0e31 000AAZ24910_BA001
C 15 | DWRFE 2031 000AB25041_AAAE1
C 16 |ALYIEWER | 0031 000AB25300_AAA01
C 17 | DWRFE 0o31 000AAZ25501_AA001
C 18 | DWRFE 2031 Q008825503 _AA0a1
C 18 | DWRFE 2031 000AB25507_AAA0
C 20 | DWRFE 0031 000AAZ25609_AA001
C 21 [DWHTTP |B045 000AA25710_AA001
C 22 [DWHTTP |B045 Q0082571 1_AAAE1
C 23 [DWHTTP  |0045 000882571 2_AAa01
C 24 [ALYIEWER|BO31 000AAZ25700_AA001
[+]
[~]
| [ | FM1 (23 (200) fetsap  OVR

15. Double click on the spool request number representing the newly
created printlist. Press the Execute button or F8 to start the archiving
process. The request is sent to DWSAP for processing.

Data Archiving

The data archiving process is used to reduce the size of the SAP R/3
database primarily for performance reasons. SAP R/3 has the ability to
create a data archive file that contains data records from tables. This data
archive file is created and stored at a temporary location. SAP R/3 does
not have a permanent storage archiving system to store the data archive
file that it creates. The data archive files created are stored on FileNet
Image Services (IS) via DWSAP. After the data archive file has been
created, data is deleted from SAP R/3 database. Then, data archive is
stored or archived onto FileNet IS via DWSAP. The temporary data
archive file is deleted after the archival is complete.

Follow the steps listed below to create a data file and archive it to FileNet
IS:

March 2003

FileNet Document Warehouse for SAP 57



Document And Data Archiving
Data Archiving

1. Go to archive management screen through Tools - Administration
-> Administration - Archiving (Transaction sara). The following
screen is displayed:

Archive Management: Initial Screen

| Customizing ||.J0b Overview | | DB tables || Information system |

E Archive
i Delete
tl Poster.
ﬁ Reload
. Analyze

g Index
)

G Managemem

A 3 VMO TG

2. Enter the archive object name as FI_DOCUMNT and press enter. The
following screen is displayed:

g  uliH ©@@ 2 m

Archive Managemeni: initial Screen

| Customizing ||J0b Dver\riew” B tables || Infarmation system |

a Archive
a Delete
Postor. |
ﬂ Reload
. AnaIEe

Indesx

4 Management

- Db]|carald metsap

Note: Archive objects are the core of SAP data archiving. It specifies
which data is archived and how it is archived. It also describes which
database objects must be handled together as a single business object
and which must be interpreted independently.

3. Click Archive. The following screen is displayed:
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Archive Management. Create Archive Files

| Archive directory || Customizing ||J|:|b OvErview || Management || DB tables

Financial accounting documents
Client aen

Watiant BRCHIY_WARTANT @ & Maintain
User name BASIS

li@ Start date @20 not maintained

Spool params. @@ not maintained

4. Enter the name of a variant to be created. This variant is used to
specify the values of financial documents that will be archived. Click
Maintain button. The following screen is displayed:

5] iR c0e CHE Dnon BN B —

=H
Maintain Variant: Report SAPF048, Variant ARCHVE VARIANT

Archiving guantity selection
Comparny codes 18080 1000
Dacument numkbears 100102211 100102300
Document type LB CI
Fiscal yeariperiod 18991 1 1981 12
Min.no.of days in the system
Key date 17.02.2003

Frogram cantral

[] Testrun
Detail log
[] Onlyincarrect docs in det.log

FR1 (1) (800) PE| metsap  OVR

5. On the screen for variant maintenance, enter the selection criteria to
identify the financial documents that need to be archived. Press Save
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to save the variant. Make sure that the check box Test Run is not
selected. If it is selected, then the data will not be archived and just a

test run would be executed. After saving the variant return back to
Archive management screen.

| 0 a0 Bieee SHE SDADIEE @
Archive Management: Create Archive Files

| Archive directory || Customizing ||J0b OE i By || Management || DB tables || Information system

Financial accounting documents
Client a0e

I

Wariant PRCHYE_VARIANT [@) (B Maintain |

User name BRSIS

Start date @22 not maintained
Spool params. @2@ notmaintained

& Attributes of variant AR CHVE_VARIANT saved [+ L FMT 1y g0y b2

6. On the archive management screen, click the Start date button. The
following screen is displayed:

Atoperation mode | {»2]

After job At operation mode

v o B %
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7. Click Immediate and then Save the settings. On the archive
management screen click Spool params button. The following screen
is displayed:

Background Frint Farameters

Qutput device BT Printer
Murmber of copies 1

Mumber of pages
@ Print all
1 Print fram page Tao

Spoal request

Narne SAPFO48__BAS

Title Financial accounting documents
Autharization

Spool options

[ Printimmediately Cover sheets

[ Delete after output [ SAP cover page

Mew spool request [ OperSys cover page
Frint priarity 5 Medium [] selection cover page
Retention period 8 Davyis) Recipient BASIS
Archiving mode Archive only Department

Frint settings

Lines 65
Columns 132 [ without contral chars
Format ¥_GR_132 ABAF list: At least 65 rows by 132 colum

14 ﬁj User-specific print parameters | 3§

Maintain spool settings and select do not output immediately.

Press Execute or F8. Go to Job overview sm37. The following screen
is displayed .After a while, three archiving jobs are displayed and
have a status of finished.

Edit

Jdob Goto  Extras  Seftings term

2d H  eae SHE Ohoan AR & m

Help

Joh Overview
& A Release @ T & sSpool By Jobloo S step & | B3 Application serers B8 @ F & F

Johiame Ln|{Job CreatedBy|Status |Start date|Start time|Duration(sec.)|De ;
[ ARY_FI_DOCUMNT_DEL200302171 70630 | G| BASIS Finished |17 .02 200317 :606:30 14
[ ARW_FI_DOGUMNT_SUB20030217170628 BASIS Finished |17 02 2003|17:606:28 ]
[ ARY_FI_DOCUMNT_WRIZO03021717A628 | G BASIS Finished |17 .02 2003|17:06:28 2
*Summary 16
[4]
[+]
LDl [ I[«[+]

| D [ Fu1 (1) (800) b2l fnetsap | OVR /7

10. On archive management screen, click Management that brings
Archive Session Overview screen:
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hive management Edit Gaoto

Archive Management: Archiving Session Overview

@ @ & B,; Spool list  Archive systerm | Customizing = Joh overview | DB tables  Information system

B 008832 62.12.20802
8 008848 21.10.20802
@ DO796 27.08.2002 Test for ServerLinkd4 .1l
8 006754 25 08 2002 Test for SerwverlLinkd .1
8 08a742 19.08. 2002 Test for Data Archiwing
—E 000735 14.08 2002 Test for ServerLink4 .1l

[41+]

—@@@ Complete archiving sessions

—Oa 0E0922 17.02. 2003 Test for Data Archiving
[ 008921 17.02. 20803
0O 0OE920 17.02.2003
3 008918 17.02. 2003
—C3 008918 17.02. 2003
O 0Oea17 17.02.2003
03 008916 17.02. 2003
[ 008315 17.02 28083
0O 0oea14 17.02. 2003
—E 000913 17.02.2003 Test for Data Archiving

QE1FI_DACUMNT] Deletion completed

—a 00e912 17.02 2003 Test for Data Archiving
— 008911 17.02.2003 Test for Data Archiving
8 00910 17.02.2003 Test for Data Archiving
08 OBE908 17.02. 2003 Test for Data Archiving
B 008988 17.02.2003 Test for Data Archiving
08 08E907 17.02. 2003 Test for Data Archiving
08 O0BE906 17.02. 2003 Test for Data Archiving
8 008985 17.02.2003 Test for Data Archiving
D3 006984 17 .02 2003 This is a test variant
0 OEES03 17.02.2003 This is a test variant
O 00982 17.02.2003 This is a test variant
—C3 008981 17.02.2003 This is a test variant
0O OeES0E 17.02.2003 This is a test variant
O 008899 17.02.2003 This is a test variant

Do oW oW oW oW

Eln

b [FN1 (1) 800y " Metsap  OVR

11. Under the complete archiving sessions branch, there is a new session
with the current date.

12. Select this session and click the Archive system button. The
following screen is displayed:

913
Status complete
MNote Test far Data Archiving
Archive file Status Storage
000913-001F1_DOCLIM . Deletion completed not stored ArcE|

an

D] [}

o 5] Storefiles ¥

13. Click the Store files button. The following screen is displayed:
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Archive Management: Store via Archivelink
Archiving 914
Status complete
Mote Test far Diata Archiving
Archive file Status Storage
000924-001FI_DOCUM .. |(@@@ Deletion completed @O@ stared eoD Arch‘
[ I[«][v]

o 5] Retrievefiles 3

14. A request is issued to DWSAP server components. The status of

storage will change from Not Stored to Request Made. After some
time and refreshing the screen, the status eventually changes to
stored. This means that archive file has been stored in the FileNet IS.

Display Archived Data

Follow the steps listed below to retrieve a data file:

1.

Go to display document screen of financial accounting, transaction
fb03.

Enter the same document number that has been archived in the
previous steps and press Enter.

The dialog box comes up saying that the document is not in the
database.

Click Yes and a request is made to DWSAP and the document is
displayed from archive. This is called a partial restore.

In order to do a full restore of the data, go to archive management
screen, transaction sara, enter archive object as FI_DOCUMNT .The
following screen is displayed:
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Archive Management. Initi...

| Customizing | | Joh overview || DB tables || Infarmatic

Archive

Delete

Postpr.
Feload
Ahalyze

Index

mManagement

—@@¢g Complete archiving sessions
—T QAR924 17 .02 2003 Test for Data Archiving
Oooaz24 -0 1FI_DOCUMNT @@@ Deletion completed

—. QAR9Z3 17 .02 2003 Test for Data Archiving
—. QAR9ZZ 17 .02 2003 Test for Data Archiving
0 @EEs21 17.082.2003

—0C GAES2E 17 82 2003

0O BEES19 17 62 2003

—0C BEE918 17.682.2003

0 BREESITF 17.082.2003

01 OAES1E 17 . 082 2003

0 @AES15 17 82 2003

—0C BEES14 17.082.2003

—E8 BEE913 17.02.2003 Test for Data Archiving

—E8 pRegi2 17 02 2003 Test for Data Archiving
—. AAE911 17 02 2003 Test for Data Archiving

[l [ [« (]

(][> | [ («][]

SaRA M2 fhetsap
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7. Select the archive run and click Archive system. The following
screen is displayed:

Archive file Status Storage
000924-001FI_DOCUM.. |@@@ Deletion completed @Oe stored [ & ] AI‘CE

Ll [ 4 ][]

v @ revenes | %

8. The screen shows the status of the archive run as stored. Click on
Retrieve files. A retrieval request is made to DWSAP and the
complete file is restored from the archive.

9. Leave the management screen. And return back to Archive
Management. The following screen is displayed:

Archive Management: Initi...

| Customizing ||an OWE i ewW | | DB tahles || Informatic

Archive

Delete

Postpr.
Reload
Anahze

Index

Management

March 2003 FileNet Document Warehouse for SAP 65



Document And Data Archiving
Data Archiving

10. Now, choose the function reload for the archive object
FI_DOCUMNT.

11. Maintain a variant for this reload and enter the document numbers
that you want to reload into database.

12. Click the Archive selection button. The choose files to reload screen
is displayed which shows all the complete archiving sessions. Select
the archive session from which the data is to be reloaded. Also,
specify the start date and spool parameters as above.

Note: Reloading data is not possible for all the archiving objects.When
reloading data, SAP R/3 can only process complete archiving sessions.

13. Press Execute or F8 key. This will generate new jobs for reload.
These jobs can be verified in the job overview, transaction sm37.

14. The completion of these jobs means that the data has been restored
in the SAP R/3 database.

15. Display the financial document from transaction fb03. Now, the
document will be displayed from the database and not from the
archive.
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Document Retrieval And Display

This chapter describes how to retrieve and display documents and
printlists stored on the Image Services (IS) library. The following viewers
are supported for document display by DWSAP:

e FileNet IDM Viewer.
e Internet Explorer.
e Custom Viewer.

Printlists can be displayed in either SAPGUI or ArchiveLink viewer.

Displaying PDF Documents

For document types other than printlists, the following viewers are
supported:

e FileNet Viewer.

e Internet Explorer.

e Java Based Viewer
e Custom Viewer.

In order to display all the documents other than printlists stored in IS
library perform the following steps:

1. Click Tools = Business Documents 2> Miscellaneous = Stored
documents or transaction oaad, in the main window of SAP R/3, the
following screen is displayed:
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G| 000 waH e@e DHE
SAF ArchivelLink: Administration of stored documents

Assign subseguentl

SAP Archivel ink: Stored documents search

()

3

Business object
Client

Archive

Document ID

Document type

Dacument class

Archiving date fram 11.02. 2003
Archiving date to 11.082. 2003
Delete date

- U|omDbd metoap
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3. Enter selection criteria to search for linked documents. Any
combination of the above criteria can be used to get the linked
documents. Press Execute or F8 key to continue.

4. The linked documents corresponding to the above search criteria are
displayed as shown below.
List  Edit ysterm  Help

i 390 CEQ DHME HDO
SAFP ArchiveLink: Hit list for stored documents
FEwomddasd%EEREEBRT M chose @ swe T H

Goto

Settings

Ohj. type SAP ohject ID Il
Archive Document ID |
Doc . type Stroge date Delete Doc. class Status
[ BEKPF DARADTFREO
R 108113
ZR1FDF 16.081.2003 PDF
[ EKFPF DARADTERRAE
R 100943
ZR1FDF 16.01.2003 PDF
[ EKFPF DARADTFRRAE
R 1083592
ZR1FDF 20.01.20083 PDF
[ EBEPF DARAOTFQAR
R1 104007
ZR1PDF 16.81.2003 PDF
[ EBEKPF DARAOTFQAR
R1 104577
ZR1PDF 20,01 .2003 PDF
[ BKFF DARAOTFOAO
R1 1B5560

BN
| b | 0saD Pef inetsap NS 7

5. Double click on one of these entries. The following screen is
displayed:

Edit Goto H
DA H ea@ DHE DO HEE @@
SAP ArchiveLink: Hit list for stored documents

Stored docurments

@& & Ei'=| [ @ Reassign assign subseguently | Change document type

Client 88a 1=
Business ohject BKPF .44
Accounting document
Object key DARAOTFAO1
Company code DARA
Document number OTFEE1
Fiscal year
CortServer R
RFC &rhive Tor UTC Online Admin
Document 1D 260073
Doc . type ZR1PDF
pdf doc type for ri
Arch.date oy .61.2e03
Expiry date 0@.oa. gana
Doc. class PDF

Fortable Document Format

Storage date (external) 0O7.01.2003
Storage time (external) 00:29:01
Content sryr status ONLINE

[l

0]l I[«[»]
[ [ [ 0asD P2 Metsap | INS
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6. To display the document, click the Display button. The following
scenarios exist when displaying the documents:

Display in FileNet IDM Viewer: In this case, SAPGUI
communicates with the FileNet IDM Desktop for R/3, which
invokes the FileNet IDM viewer to display the linked document.

Display in Internet explorer in Server add-on environment: In this
case, SAPGUI communicates with IDM desktop for R/3, which
displays the document in Internet Explorer.

Display in Internet Explorer in Pure-thin environment: In this case,
none of the FileNet component needs to be present on the client
machine. SAP sends the display request to DWSAP server
components and displays the document in Internet Explorer.

Display in a custom viewer: Customers can also use their custom
viewers to display the linked document. For details on how to
achieve this, refer to DWSAP 5.1 Installation and Configuration
manual-Client and Programmer’s Handbook.

Note: Customers need to customize their SAP system differently for each
of the above stated scenarios to work properly. For details on how to
configure SAP R/3 for the above scenarios, refer to Installation and
Configuration manual-Server and Installation and Configuration Manual-

Client.

CAUTION: Documents having document types ALF and OTF, proprietary
document types of SAP, cannot be displayed using the above viewers.

Displaying Print Lists

Print lists are the reports produced from SAP. These can be printed,
archived to the IS library and stored on optical disk in a single operation.
Print lists can be retrieved either directly in the SAP office module, or
through the Archive Objects Administration module of the ArchivelLink
Interface. Printlists can be displayed in the following viewers:

SAPGUI.

ArchiveLink Viewer.

To display the Find Archived Print Lists dialog box:

1.

From the SAP R/3 main window, click Office > Business
Documents - Find Lists menu. The following screen is displayed:
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Find stored print lists

. ©b]osDR b metsap

2. Enter the following search criteria in the respective fields:

Field

Description

Report Name

Denotes the type of print list.

Archiving Date (From/To)

Denotes the date range when
the print list was archived.
(nn/nn/nnnn)

Object Type

Denotes the type of object
associated with the print list,
such as Document.

Document Type

Denotes the document type,
such as General Print List.

3. Todisplay a list of matching print list reports, click the Execute button.

The following screen is displayed:
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List Edit

Goto

ystem

BaH I eEa@& BHEE D

Settings

Help

SAP Archivelink: Hit list for stored print lists
G B & T &k EEE TS ® chose [ save TF 2 B

[«]
Repart name Info Agent Stroge date E‘
Text
r1 BASIA 13.02. 2003
Testi [
[ RFEEL.J@ ri BASTS 13.62.2003
Test1
[ RFEEL.JAE r1 BASIA 13.02. 2003
Testi
[ RFEEL.J@ ri BASTS 13.62.2003
accpetance?2
[ RFEEL.JAE r1 BASIA 13.02. 2003
accept
[ RFEEL.J@ ri BASTS 13.62.2003
Locceptance
[ RFEEL.JAE R1 BASIA 11,02 2003
PrimtList Brchival —
[ RFEEL.J@ R1 BASTS 11.62.2003 E‘
1| [ [«][»]

[ | OADR P2l | fhetsap | INS

4. To retrieve the full index attributes for the archived Print list, choose
any one of the report names, and click Choose Details button. If the
print list is available for retrieval, then the status is displayed as
ONLINE, otherwise the status is displayed as OFFLINE.

Printlist Edit Goto

tern  Help

B dH @@ EHE HhOon E

SAP ArchivelLink: Hit list for stored print lists

d2 33 Printfrom content server

Client
Report

Info

Seq. number
Printer

Form
ShortTxt
Users
brechiving date
Storage time
Expiry date

gog

RFBEL.GG

R1

QEEEa1 49685

BT Printer
X_B5_132
FrintList Archival
BASIS

11.682 . 20083
13:08:07

141> ]

CrtSvr R1

RFC Arhiwe for UTC Online Admin
Document ID 191651
Business object BKFF

Aocounting document
Doc. type ZR1ALF

alf doc for ri1 archive
Size (in hytes) 164236
Storage date (ext.) 11.02.2003
Storage time (ext.) 12:24:57
Content srvr status OMLINE

[0 ]I

K1

|[dl]

[ | 0ADR PEl | fetsap | OVR 2

5. To retrieve the print list from the IS library and display it, select
Printlist > Display from Content Server. Depending on the protocol
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configuration, the Printlist can be displayed in either SAPGUI or
ArchivelLink Viewer.

Displaying Printlist In SAPGUI

As of SAP R/3 release 4.5B, Print lists archived to FileNet can be
displayed in SAPGUI. Searching for a text string and searching for
attributes is also possible. But this functionality of searching for print lists
is possible only for those print lists that are archived to HTTP content
servers. In case the print list is archived to an RFC content server, free
search and attribute are not available. In order to customize SAP R/3 to
display print lists in SAPGUI, refer to Installation and Configuration
manual-Server.

On selecting Printlist > Display from content server, the print list is
retrieved from FileNet IS and displayed in SAPGUI as shown below:

Printlist Edit Goto Swstern  Help w
B dH e BEE
Display of stored print lists

IDES MG Compact Document Jow E‘
Frankfurt E
Document header Subledger accounts
CoCd Document o Fosting & fccount Posto Open item amount

number Ty date T numher oy L in DEM (FC

100 168000723 DA 01.10.1999 (0 QoQQQE3450 @1 6,900, a
Reference: CEQEEET 32000MY50 | D 0O00OQAR3450 Q9] LTICT T =

[ pEEOEE3450 19K R34.7

[ BEEEEE3450 09 2T T

[ DEEOEE3450 19K 32T T

1000 1600000724 DA 01 .10.1999 (0 QOEEEE3453 ©1 G,969.0

Reference: BERREET3Z00EMYS0|D OOOOAR3453 A9 414.0

[ BEEOEE3453 19K 414.0

[ poooao3453 09l a7.h

[ pEEEEE3453 19K 575

1000 16EREEEY25 DA 01.10.1999 (0 QOEERO3454 @1 T,475.0
Reference: BERREETIZEEEMYS0|D OOOOAR3454 @9 4608 |
[ BEEOEE3454 19K 460 .0 E|
[+]

[l [ |[«[»]

| [ | 0ADR 2] | fnetsap | INS /7
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Searching for a Text String

The Free Search feature of SAPGUI is used to search a text string in a
Print list document stored on the IS library. The search is conducted
directly on the data file of the print list. To search a displayed print list for

a specific text string:

1. Click Edit > Free Search menu. This displays the Find dialog box, as
shown in the figure below:

Printlist  Edit Gota tern  Help

BlaH @@ CHEmDLn HE @

Display of stored print lists

& ‘ () Free search | [H) Attribute search

IDEE AG Compact Document Journal Time 11.51.33 Date 0OF.02.2003
“rankfurt RFBELJOO/BASIS Page 1
Document header ‘ Subledger accounts Taxes G/L accounts
Free search
CoCd Doc sépur. |Tx Postg GilL G/L account
num Find | in DEM |cd ky account a mount in DEM
1000 0100 - 48 @E2120 1,812.46
@ from cursor
0 globalin list
1000 010 4 @62128 1,812 46
[ Case-sensitive
1000 019 | R 40 @e2120 222.92
ot T
1000 0100101729 AB O7.11.2002|K 0000001950 25 222.93 50 @ez120 27, 463.59-
K 0D0B001950 25 1,812 46
K 00DEOO1950 25 1,812.46
Kk 0DOE001950 25 1,0868.00
K 000EO01950 25 17,705.91
K 0000001850 25 222.93
K 0008001950 25 123 00
K 0000001950 25 1,114 .65
K 0D0B001950 25 66879
K 00DEO01950 25 1,812.46
1000 0100101730 AB O7.11.2002|K 00000019560 21 123.00- 48 @e2120 122,00
1000 0100101731 AB OF 11.2002|K 0000001358 25 123 086 5@ @62128 123 088-
1000 0100101733 AB 18 11 2002 |K 0000001358 25 181.25 5@ @62128 181.25-
[USD 188.88)
1000 0100179682 AR 26.11.2002|K 00000019560 21 123.00- 48 @e2120 122,00

1> Foapr bel metsan | ovi
2. Tofind all the occurrences of the desired text string, enter the text
string in the Find textbox, and click enter. The user can also choose to
search from the current cursor position by selecting the from cursor
radio button or in the entire Printlist by selecting the global in list
radio button. Checking the case-sensitive check box carries out the
case-sensitive search.

Searching for Attributes

The Attribute Search feature searches a SAP print list document stored
on the IS library for a record that matches attributes as mentioned in the
search criteria.

To perform attribute search in a Printlist:
1. Click Edit > Attribute Search.

2. Enter the search criteria and then press search. The SAP ArchiveLink
viewer searches the description file of the print list for the above
attributes.

Creating Notes
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The DWSAP supports the creation of Notes on print lists from SAPGUI.
To create a Note associated with the Printlist:

1. Click Print list > Create note menu in the displayed print list. The
following screen is displayed:

Printlist  Edit Goto tern  Help

& A ICE@ SHE HDLa0IER @

Dispiay of stored print lists

@ | ﬂ:".] Free search ﬂﬂ Attribute search

IDES AR Compact Document Journal Time 19 80 28 Date A7.02 2003
“rankfurt RFBEL JOG/BASIS Fage 1
N | = Create note
Document header G/L accounts

r—  This is a test note)|
CoCd Document Do Post: GiL account

number ty date a mount in DEM
1000 188181689 AB 11 8¢ o 222 .93

K ALl ]
v ®

[ I | 0ADR PE| fhetsap  OVR

Enter the text for the note in the above screen and press Save.

This sends a request to DWSAP and the note is stored.

In order to display the note added, click on the menu item Print list >
Display note. The notes added on a print list are displayed in a new
screen as shown below:

March 2003 FileNet Document Warehouse for SAP 75



Document Retrieval And Display
Displaying Print Lists

Printlist Edit ¢

em Help
ldHIC@ @ CRE IS0 00 ) EE )@
Display of stored print lists

R, % | [ Freesearch [H} atribute search

IDES AG Compact Document Journal Time 18.00 28 Date 07.02.20083
Frankfurt RFBELJOO/BASIS Page
Document header L accounts
———— This is a test note.
CoCd Document Do Posting 07.02.2003 19:25:108 INDIA BASIS (BASIS IDES) G/L account
number: ty date # a mount in DEM

————— 9: 25 5 DES)
1800 0100101629 AB 11.09.1 222.02

[ADL ALl
LalvZalt 3

| [> | 0aDR fnetsap  OWR

5. Users can also add more than one note on a print list. This can be
done through menu item Print list & Expand on note. The following
screen is displayed which has the note previously added in display
mode. The additional notes can be added in the extra text boxes
provided and pressing Save.

Printlist Edit Goto N Help

Bl H I ©CE@ S @ME 2Do8 | EHE @
Displiay of stored print lists

=, % | | Free search |[H] Attribute search

[DES AG Compact Document Journal Time 18.00.28 Date @F.02. 2003
‘rankturt RFBEL.JOE/BASTS Pane 1
Document heade B/L accounts

—————— This is a test note
CoCd Document Do Po 07.02.2003 19:25:10 INDIA BASIS (BASIS IDES) /L G/L account

numher ty da This is Test Hote #1 nt a mount in DEM
— O7.02.2003 19:29:25 INDIA BASIS (BASIS IDES)
1000 @108101689 AB 11) This is test note #2| 120 222.93

L A]
Lalv7 ®

[ | 04DR P fetsap | OVF
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Displaying Print Lists In ArchiveLink Viewer

SAP ArchivelLink Viewer can be used to display archived documents.
Print lists, outgoing documents in OTF format and incoming documents in
FAX format can be displayed using ArchiveLink Viewer. This viewer uses
the functions provided in the IDMForR3.DLL to retrieve documents stored
on the FileNet system. For displaying Print list in ArchiveLink Viewer, SAP
should be customized accordingly. For details on configuring SAP system
for display in ArchiveLink Viewer, refer to Installation and Configuration
manual -Client.

Using SAP ArchiveLink Viewer you can:

Print to a UNIX server using a spool independent of SAP SAPspool.
Print locally through Microsoft Windows.

Display and edit a note already displayed with the associated
displayed document.

Create a note if one does not exist with the document.

Select and de-select a displayed document.

Copy a selected area of a document image to the Windows clipboard.
Select an entire page prior to copying to Windows clipboard.

Search a displayed print list for a text string.

Search an indexed print list for record matching attributes.

Navigate through a document using the first page, next page, and
previous page commands.

Navigate between the documents using the first document, next
document, previous document, and last document commands.

Manipulate Windows using the tile and cascade commands.

The following figure shows a print list in ALF displayed in the SAP
ArchivelLink viewer:
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EArchiveLink - [alf doc for r1 archive] - IEIIﬂ
%roument Edit Goto Wiew ‘Window Help _Iﬁllﬂ
A T selael 1 == El=EE=) == ol 2]
DES AG Compact Document Journal il

Frankfurt

Document header Subledger accounts T
CoCd Document Do Posting A Account Fostg Cpen item amount Tx Tax
numhber ty date T number ky L in DEM (FC) ad am

1000 0100101682 AB 05.11.Z002 |K 0000001950 31 1,812, 46-

(UsD 1,000.00-)

1000 0100101e83 AB 05.11.2002 |K 0000001330 31 1,812.4¢6-

(Usp 1,000.00-)

1000 0100101484 AR 04.11.Z00Z |K 0000001950 31 Z2E.93-

(USD 1Z3.00-)

1000 0100101729 Ak 07.11.Z200Z2 |k 0000001950 Z5 222.93
K 0000001950 25 1,812, 46
E 0000001950 25 1,812,468
K 0000001950 25 1,%65.00
K 0000001950 Z5 17,705,511
K 00000015950 25 222.93
K 00000015950 25 1z3.00
K 00000015950 25 1,114.65 hs
y | of
[Ready noTE | Y

Searching for a Text String

The Free Search feature of SAP ArchiveLink viewer is used to search a
text string in a Print list document stored on the IS library. The search is
conducted directly on the data file of the print list. To search a displayed
print list for a specific text string:

1. Click Edit > Free Search menu. This displays the Find dialog box, as
shown in the figure below:

" Direction—— Cancel

" Up * Down

[ Match case

2. Tofind all the occurrences of the desired text string, enter the text
string in the Find textbox, and click the Find Next button.

When a search is executed, the displayed page of the print list is
searched first. The first occurrence of the text string is highlighted. If the
text string is not found on the displayed page, the text string is passed to
DWSAP client components, and the search continues on the remaining
print list in cache. If the text string is located, the relevant page is
retrieved to the workstation, displayed, and the matching text string is
highlighted.
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Searching for Attributes

The Attribute Search feature searches a SAP print list document stored
on the IS library for a record that matches attributes as mentioned in the
search criteria.

Note: Attribute search is supported for only those print lists that are
generated in background and store a description file along with the data
file.

To perform attribute search in a Printlist:
1. Click Edit - Attribute Search. The following dialog box is displayed:

Attribute Search x|

[T SeachUp
— Attributes ;

Client [
Dioc. status I_
Company code I—
Fizcal year I—
Document number I

| Search I Cancel Help

2. Enter the search criteria in the above dialog and then press search.
The SAP ArchivelLink viewer searches the description file of the print
list for the above attributes. This description file is generated and
archived together with the print list in the current language of the user,
for example English. The resulting pointer navigates to the correct
location in the data file.

Creating Notes

The DWSAP supports the creation of Notes from SAP applications and
from SAP ArchiveLink viewer. To display a Note associated with the
Printlist, click Edit - Note menu, from the display window of SAP
ArchivelLink viewer.

The Note Editor dialog box displays a note associated with the displayed
document, as shown in the figure below:
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x
=
This is a Note
Cancel |
Extend |
hd|
Kl I
| =
hd

To add new text to the existing Note or to create a Note, click the Extend
button in the Note Editor window. The Note is sent to the IS library, where
a FileNet annotation is created and stored with the document.
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DMS Sample Web Application

A DMS sample web application is packaged along with DWSAP 5.1
Server add-on. This sample application exposes the DMS functionality
over the web. Using this application, multiple users can simultaneously
link the FileNet objects to SAP Document Info Records (DIRs).

Using the sample application, the user can:

e Browse the contents of FileNet Libraries and select the FileNet
objects that need to be linked to DIRs.

e Link FileNet objects to DIRs.

e Create new versions of DIRs.

e Unlink DIRs from the FileNet objects.

o Link FileNet objects to Material Master.

o Display Material Master Records linked to FileNet object.

Accessing The DMS Sample Web Application

The DMS sample web application can be accessed through a URL. The
URL is of the form

http://ServerName/idmws/dwhome.asp
Where,

ServerName is the name of the server on which DWSAP 5.1 server add-
on is installed.

Dwhome.asp page is the home page of DMS sample web application.
This page loads all the FileNet libraries configured on the server as
shown below.
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Fle Edit “iew Favorites Tools Help

Address I hitp: #7fn_testw 2k DbWS dwhome, asp j @ Ga

Libraries

== FILENET

Document Warehouse™
for SAP

©2003 FileNet Corporation. All Rights Reserved.

‘@ Daone ’_ ’_I_ E Local intranet

Browsing The Configured Libraries

On the above page, select the library to logon to a library. The logon
dialog is displayed as shown below:

/2 Logon to IMGSERY - Microsoft Internet Explo i ]
% IMGSERY ok |
User name: Cancel |

Password:

Help |

After logging on to a library DMS toolbar is loaded which exposes the
DMS functionality. All the configured SAP systems are also loaded. The
SAP system to which the FileNet objects can be linked can be selected
via this list.
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Note: DMS toolbar is disabled unless a document or a folder is selected

/] Cannot find server - Microsoft Internet Explorer -0 =|
File Edit ‘jew Fawvorites Tools Help |

P Back ~ = - @ ot | @Search [3e] Favorites @Media @ | %v =] E - .

Address J G | Links

Libraries | ﬁ Q@“ﬁ( E&'E;@|
BB B B SE [r -l

il IMESERY
@ Accounts
& Admiriztration
@ Finance:
= T
@ Hozpital
@ b ark.eting
U Medical
@ ParentFolder
@ ReszearchDeviopment
@ Syztems
@ Tilmages

| Uiles |0 object(s
|&] Done C 1 @B Local intranet V.

Select a folder to display the contents of the folder as shown below.
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/3 Cannot find server - Microsoft Internet Explorer =10l x|
File Edit Yiew Favorites Tools Help ﬁ
A Back - = - @ il | @_Search [Fe] Faworites @Media @ | %v =3
Address IE http: fifn_tesbwzks idmws dwhome, asp j f?GD Links **

e [ @ QR DRI BT x[Head]?

P A e
ﬁ IMGSERY = M ame Entry date Pages
. ‘3 Accounts c@ il 124115/2002
| .[.“E 3 lmiistration C [# 130912 2/5/2003 1
= O Finance € & 190m3 2/5/2003 1
e =P " # 191650 2A0/2003 1
D Hospital C ®liararr 2/13/2002 1
55 M arketing
O Medical
@ ParentFolder
55 RezearchDevlapment .
|;| Systems j
| 5 object(s)
@] I_I_I_ (5F Local inkranst 4

DMS toolbar exposes the following functions which are explained in the
subsequent sections:

e Link FileNet objects to Material Master.
o Display linked material master records.
e Publish document to SAP R/3.

e Change document status.

e Unlink R/3 objects.

e Publish current document version.

Link To Material Master

This function allows searching for material master records in SAP R/3 and
linking the selected material master record to the selected FileNet object.

The following procedure needs to be followed in order to link material
master records to FileNet objects:

1. Select the library and the object that needs to be linked to the material
master record. Also, select the SAP system for which the link is to be
established.
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2. Click onicon = . In case in the configuration tool the option Prompt
for DIR Status and Description is enabled in Client > DMS , a
dialog box is popped. If the option is disabled in Configuration tool,
then skip to step 4.

3 Update DIR Description and Initial Status - Microsoft Internet Explor: _ ||:||1|

Update DIR Description And Initial Status

DIR Description IDefauIt DIR

Initial Status IFH--HeIeased 'I Cancel I

|&]) Done l_ l_ l_ E Local inkranet v

3. Enter the value of the DIR description and select the status of DIR to
be created and click Ok. The following screen is displayed:

/3 Link To Material Master - Microsoft Internet Explorer o ] 4

Link To Material Master
Material Id I

Description I Search |

|&] pone ’_l_’_ g' Lacal intranst Y

4. Enter the search criteria for searching material master records in the
above window by entering the values for Material |d and Material
Description. After entering the search criteria, click on the Search
button to execute the search.
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5. This searches for the material master records in the selected SAP R/3
system. The following screen is displayed:

4 Link To Material Master - Microsoft Internet Explorer o ] |
Link To Material Master
Material Id Im-D"
Description I Search |
I atenial [D Descrption =
M- Sunny Sunry 07 - Test
& M0z Sunny Hal
= M-03 Sunry Tetral3
i M-04 Sunny Extreme Test
= M08 Flatscreen LE S0P
MO Flatzcreen S 1460 P
= M7 Flatzcreen LE B4P
= M08 Flatzcreen M5 1575P |-
M09 Flatscreen MS 1585 i
LCirate Cancel
|éj Done l_ l_ l_ Local intranet i

6. Select the material master record that needs to be linked to selected
FileNet object. The Link button is enabled.

7. Click on the Link button to link the selected material Id to the FileNet
object through a DIR. A DIR is created in SAP R/3 and the DIR Id is
popped up as shown below. Click on the Ok button to acknowledge
the message and the window closes.

Display Material Master

This function displays material master records linked to the selected
FileNet object.

The following procedure needs to be followed in order to link material
master records to FileNet objects:

1. Select the library and the object for which material master records
need to be displayed. Also, select the SAP system for which the link is
to be established.

2. Click on the icon e . This launches a new window and all the
material master records linked to the selected FileNet object are
displayed.
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3 Display Material Master - Microsoft Internet Explorer - |EI|5|
Display Material Master
M aterial D ata General 1=
old ]
tdatenial [0 td aterial D esc. rl‘:d;:tlesgl;:ory Diivizion katerial Hierarchy H:;;.Ere Lab/Office
Mumber
M-01 sunny Sunne 07 - gonr 7 5T
Test
000000000000000038 Classification test 933 5T
00000000000000005g " Entilation, 5T
complete
00000000000000005G 2 Potable Thon gy 5T
crane
00000000000000007e Companent Ful 5T
Repair Service
000000000000000088  A5-100 T-ghirt nzo04 03 5T
Febate
0000000000000001 70 zettlement; glogz 004 0z 5T
paints 1=
00000000000000018g AW Sontract 00 5T
raterial
#1000 buotar, lectical 4 o o7
purnp 250K\ hd!
Done |
|éj Done l_ l_ l_ Local intranet i

Publish Document To SAP R/3

This function creates a DIR in SAP R/3 and a link is established with the
selected FileNet object.

The following procedure needs to be followed in order to link material
master records to FileNet objects:

1. Select the library and the object for which a DIR needs to be created.
Also, select the SAP system for which the link is to be established.

2. Click on the icon “=* . In case in the configuration tool the option
Prompt for DIR Status and Description is enabled in Client > DMS
a dialog box is popped. If the option is disabled in Configuration tool,
then skip to step 3.
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/] update DIR Description and Initial Status - Micrasoft Internet Exploi o =l |

Update DIR Description And Initial Status
DIR Description |Default DIR

Initial Status IFH--HeIeased 'I Cancel I

@) Dane RN
3. Enter the value of the DIR description and select the status of DIR to

be created and click Ok. Clicking Cancel will create DIR with the
default values.

Microsoft Internet Explorer

4. Click OK to acknowledge the message and the window closes.

Change Document Status

This function allows changing the status of DIRs linked to selected
FileNet object in SAP R/3.

1. Select the object in the library and the SAP system.
2. Click on the icon ' A dialog box is displayed which shows all the

DIRs linked to selected FileNet object along with its current status and
list of new statuses as shown below:
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/3 Change Document Status - Microsoft Internet Explorer

DIR
¢ DRwO00000000000001000000077200000

¢ DRwO000000000000071 00000007 7300000

[Change Status Cancel

=101 x|

Change Document Status

DIR Description
58

Default DIR This is for testing of descr

Current Status Available Status

FR Released IAF! Archived 'I
FR Relzased IAH Archived 'I

@ Done

’_ ’_ ’_ _'Ig' Lacal intranet “

3. Select a DIR whose status needs to be changed. This enables the
button Change Status.

4. From the list of available status, select the new status of the DIR and
click Change Status.

5. This changes the status of the DIR to the one selected in the available
status. After the status has been changed, the web page is refreshed
with the updated value of status.

3 Change Document Status - Microsoft Internet Explorer

DIR
DRWwI00000000000001000000211500000

DRWw00000000000001 000000211600000
DRWI00000000000001 000000211700000
DRWI00000000000001 000000211800000
DRW000000000000001000000211300000
DRW000000000000001 00000021 2000000
DRW00000000000001000000212100000
DRW0000000000000100000021 2200000
DRW0000000000000100000021 2300000
DRWwI0000000000000100000021 2400000
DRWwI0000000000000100000021 2500000
DRWw0000000000000100000021 2600000
DRWwI00000000000001 00000021 2700000
DRWI00000000000001 00000021 2800000

Change Status I Cancel

O RES TES TS TS TS T e

0 T T TS S

Change Document Status

DIR Description
TestDIR

Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Test DIR
Default DIR
Default DIR

=101 x|

Current Status

FR Released
FR Released
FR Released
FR Released
FR Released
PR Checked
FR Released
PR Checked
FR Released
FR Released
FR Released
FR Released
FR Released
FR Released

|@ Done

’_ l_ ’_ Local intranet v

Available Status

[8R dchived =]
[4R drchived =]
[8R dchived =]
[8R dchived =]
[ Archived =]
[ frchived <]
[ archived =]
[ archived =]
[ achived =]
[8R dchived =]
[4R drchived =]
[ dchived =]

Note: The status of only one DIR can be changed at one time. The
application does not allow selecting multiple DIRs at a time.
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Unlink R/3 Objects

This function unlinks the DIRs linked to selected FileNet object in SAP
R/3.

1. Select the library and the object for which DIRs needs to be deleted.
Also, select the SAP system for which the links are to be deleted.

2. Click on the icon & The following screen is displayed:

/J unlink R/3 Objects - Microsoft Internet Explorer o ] |

Unlink Rf3 Objects

The object is linked to 14 DIRs.
Do You want to Unlink?

nLink | Cancel |

|@ Done l_ l_ l_ Local intranet i

3. Click Unlink to confirm unlinking all the DIRs linked to the selected
FileNet object:

4. All the DIRs are deleted in SAP R/3 and message box is displayed for
the confirmation of deletion.

Publish Current Document Version

This function is used to link a new version of a FileNet Object to a DIR,
which is already linked to the earlier version of the document. The display
of versions is enabled by default for a CS library while for an IS library the
version display is disabled in the Web Application. In case version display
is disabled, publish current document version works in the same fashion
as Publish document to SAP R/3. In case, versions are displayed, then
the system checks whether any former version of the selected document
was linked to a DIR. If a DIR linked with a former version is found, then
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the version of the DIR is incremented by one and linked to the selected
version object.

In order to publish current document version to SAP R/3, follow the steps
below:

1.

Select the library and the object for which the version is to be linked.
Also, select the SAP system for which the link is to be made.

A
Click on the icon = . This will launch a new window that will show all

2.
the versions of the document as shown below.
/i demo.txt ¥ersion List - Microsoft Internet Explorer [ =] i
21 Document: demo.txt [ID=003695850, Class=Account]
Library: cadb
Mame Version Mumber  Awailability Statuz RBeclaim Pending?  Checked In By User  Checkin Date
. @ derno.tst 3 Online Admin 20742003 12:20:10 Prd
. @ derno.tst 2 Online Admin 2002003 1219:24 P
. @ demo.tet 1 Online Admin 20742003 12:18:48 P
< | |
3 werzion[z)
T B 2
3. Select the version of the document that you want to link with SAP and
&
again Click the icon = . In case in the configuration tool the option
Prompt for DIR Status and Description is enabled in Client 2>
DMS, a dialog box is popped. If the option is disabled in Configuration
tool, then skip to step4.
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7 Update DIR Description and Initial Status - Microsoft Internet Explorer [ =] i

Update DIR Description And Initial Status

DIR Description  |Default DIR Ok i
Initial Status iFH--HEIeased __vj Cancel i

o ] T
4. The dialog box has the same default values as that configured. Enter

the value for DIR description and select the status of DIR to be
created.

5. If DIR with the default status and description is to be created, then
press Cancel, else press OK. The following screen is displayed:

Microsoft Internet Explorer i

& CIRCRW-0000000000000010000002026-000-02 created

6. A new version for a DIR is created and is displayed in the alert box.
Press Ok to exit.

Logging On To SAP System

Before carrying out any of the DMS functionality mentioned above a
connection has to be established with the SAP system. The application
automatically establishes a connection with SAP when the configuration
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option RFC Auto Logon enabled is checked. If the configuration option
is unchecked the user needs to provide logon credentials for the SAP
system and based on them a connection is established with the SAP
system.

In order to logon to the SAP system follow the following steps:

1. Select the library and the object for which the link is to be made. Also,
select the SAP system for which the link is to be made.

2. Press the corresponding button as per the desired functionality.
Following screen is displayed:

J Log on to SAP System - Microsoft Internet Explorer [ =] i
SAP Logon
Client {300
SAP Hozt Hame ;fnetsap
SAP User Ibasis
SAP Password ; **********
SAP System Mumber |EIEI

Cancel i

_— e _ =
| |BE Local intranet o

'@ Done

3. Specify the different parameters and press OK. If the connection is
established the user is presented with the next screen depending on
the DMS functionality requested. If the connection cannot be
established the above screen is again presented to the user to reenter
the logon credentials.
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ABAP
Advanced Business Application Programming. The programming language used
for creating SAP applications.
ALF
Advanced List Format. This is SAP’s proprietary format for outputting summaries
of reports such as print lists.
ARCH Output Device
A dummy printer where SAP-generated documents are placed in readiness for
archiving and/or printing.
ArchiveLink
The SAP system’s interface between the SAP system and DWSAP.
Asynchronous Archiving
When queues are used to buffer both the SAP system’s outgoing archive
requests and the incoming acknowledgment and confirmation messages.
Booking
Creating new transactions such as orders and invoices in the SAP system.
Catalog Interface Module
A module that allows the user to choose one or more documents and/or folders
for linking to a SAP transaction. Desktop for R/3 comes with three standard
Views, FileNet Browse For R/3, FileNet Queue For R/3, and Filenet Capture For
R/3,. In addition an integrator can develop a special view for a customer that can
be plugged into the Desktop for R/3.
CIM
Acronym for Catalog Interface Module.
Document Type
A document type specifies the possible usages of a document within the SAP
R/3 system.
Early Archiving
A SAP process where you retrieve committed documents from the archive
system and route the documents to another person who completes the

processing.

FAX
Short for facsimile. A SAP document type that conforms to CCITT Group 4 TIFF
format.

Hit List

A displayed list of items returned from a query to the SAP database.

Incoming Document
A scanned or archived document that can be processed in the SAP system. Also,
see NCI.

Late Archiving
A SAP process where you process work items and then retrieve and link
committed documents from the archive system.

Link table
A table in the SAP system that defines the relationships between SAP objects
and documents stored in the FileNet system.

NCI
Non-Coded Information. A document that has been scanned or faxed.
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OTF
Short for SAP’s proprietary Outgoing Text Format. This is the format that SAP
uses for outputting detailed reports.
Outgoing Document
A document created in the SAP system.
Print List
Print lists are reports produced from SAP applications such as customer and
vendor lists.
Process
The operation to be performed on a work item, as defined by the document type.
SAP
Systems, Applications and Products in Data Processing.
SAPGUI
The SAP R/3 system’s Graphical User Interface: windows, buttons, menus, etc.
Simultaneous Archiving
A SAP process where you retrieve committed documents from the archive
system, link them to work items, and complete the processing.
System Setting
A customizable screen in the SAP R/3 system that groups specific document
types together.
Viewer
The SAP ArchiveLink Viewer as well as FileNet's IDM Viewer can display
document images, outgoing documents and print lists.
Work Item
A work item is the processing of a document or a message.
Work Queue
A FileNet Workflo queue in the selected Workflo workspace containing
documents for processing in the SAP system.
Workspace
Where the FileNet Queue For R/3 searches for the FileNet Workflo queue
containing documents for processing in the SAP system.
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Appendix A — Software License Agreement

FileNet End User Software License Agreement

READ THIS NOTICE CAREFULLY, THE SOFTWARE IS THE PROPRIETARY INTELLECTUAL
PROPERTY OF FILENET CORPORATION AND IS SUBJECT TO THE MINIMUM TERMS AND
CONDITIONS SET FORTH BELOW. THESE TERMS AND CONDITIONS MAY BE SUPERCEDED BY THE
TERMS AND CONDITIONS OF THE SOFTWARE LICENSE ENTERED INTO BY YOUR EMPLOYER FOR
THE USE OF FILENET SOFTWARE. BY USING THE SOFTWARE, YOU ACKNOWLEDGE IT IS FILENET
PROPRIETARY INTELLECTUAL PROPERTY AND THAT A VALID SOFTWARE LICENSE WITH FILENET
CORPORATION IS APPLICABLE. THEREFORE AT A MINIMUM, YOU AGREE TO BE BOUND BY THE
FOLLOWING FILENET END USER SOFTWARE LICENSE TERMS AND CONDITIONS (HEREINAFTER
“Agreement”):

1. Definition of Software

The software consists of software owned by FileNet, as well as software owned by certain third party
providers (“Third Party Providers”). Each software product includes any documentation relating to or
describing such software, such as, logic manuals, flow charts, reference materials, and improvements
or updates provided by FileNet (software and documentation collectively called "Software").

2. Grant of License

A. Each Software product, including any documentation relating to or describing such Software, such
as, but not limited to, manuals, flow charts and improvements or updates provided by FileNet
(collectively "Software"), is furnished to End User under a personal, non-exclusive, nontransferable
license solely for End User's own internal use on End User’s servers and client devices (“System”)
in compliance with this license and all applicable laws and regulations. End User agrees that this
license does not permit End User to: (1) use the Software for a service bureau application or (2)
rent, lease, or sublicense the Software; (3) modify or remove any proprietary notices; or (4) transfer
the Software without prior written consent from FileNet. The Software is licensed to the End User,
not sold.

B. The Software may only be copied, in whole or in part (with the proper inclusion of FileNet's
copyright notice and any other proprietary notice and/or trademarks on such Software), as may be
necessary and incidental for archival purposes or to replace a worn or defective copy.

C. Title to and ownership of the Software and any portions (or any modifications, translations, or
derivatives thereof, even if unauthorized) and all applicable rights in patents, copyrights and trade
secrets in the Software shall remain exclusively with FileNet and its licensors, if any. Software
provided hereunder is valuable, proprietary, and unique, and End User agrees to be bound by and
observe the proprietary nature thereof as provided herein. End User agrees to take diligent action
to fulfill its obligations hereunder by instruction or agreement with its employees or agents (whose
confidentiality obligations shall survive termination of employment or agency) who are permitted
access to the Software. Access shall only be given on a need-to-know basis. Except as set forth in
this Agreement or as may be permitted in writing by FileNet, End User shall not use, provide or
otherwise make available the Software or any part or copies thereof to any third party. End User
shall not reverse engineer, decompile or disassemble the Software or any portion thereof, nor
otherwise attempt to create or derive the source code. End User acknowledges that unauthorized
reproduction, use, or disclosure of the Software or any part thereof may cause irreparable injury to
FileNet and/or its licensors, who may therefore be entitled to injunctive relief to enforce these
license restrictions, in addition to any other remedies available at law, in equity, or under this
Agreement. Further, the trademarks are owned by the respective trademark holder.

D. FileNet agrees that End User's affiliates (business entities of which End User owns or controls
more than fifty {50%} percent of the voting rights or the controlling body of the business entity) may
use the Software; provided that prior to any affiliate’s use of the Software: (i) End User accepts
responsibility for the acts or omissions of such affiliates as if they were End User’'s acts or
omissions; (i) End User shall indemnify FileNet against losses or damages suffered by FileNet
arising from breach of this Agreement by any such affiliate; and (iii) such use shall not constitute an
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unauthorized exportation of the Software or documentation under U.S. Government laws and
regulations.

3. Termination. FileNet shall have the right to terminate End User's license if End User fails to pay any
and all required license fees or otherwise fails to comply with these license terms and conditions. Upon
expiration of the license term or upon notice of such termination, End User shall immediately return or
destroy the Software and all portions and copies thereof as directed by FileNet and, if requested by
FileNet, shall certify in writing as to the destruction or return of the same. All confidentiality and non-
disclosure obligations herein shall survive termination.

4. Limited Warranty

A. FileNet warrants that it has good and clear title to or has the right to sublicense the Software being
licensed hereunder, free and clear of all liens and encumbrances.

B. FileNet warrants for a period of one year from the Shipment Date, Software used in a manner for
which it was designed will perform the functions described in the applicable FileNet documentation
supplied at the time of delivery provided that, (i) Software is continuously subject to a FileNet
Software Support contract, (ii) any substantial nonconformance is reproducible, and (iii) the
substantial nonconformance is not caused by third party software or hardware not specified in
FileNet's documentation or not expressly authorized in advance by FileNet. FileNet's sole obligation
and liability hereunder shall be to use reasonable efforts to remedy any material non-conformance
which is reported to FileNet in writing within the warranty period.

C. End User accepts sole responsibility for, system configuration, design and requirements, selection
of the software for the intended results, modifications, changes or alterations.

D. THERE ARE NO OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NONINFRINGEMENT WITH RESPECT TO THIS AGREEMENT,
THE AGREEMENT, OR THE SOFTWARE LICENSED HEREUNDER. FILENET DOES NOT
WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPPTED, THAT
THE SOFTWARE IS ERROR-FREE, OR THAT ALL ERRORS CAN BE CORRECTED.

5. Export. End User agrees that the Products purchased hereunder will not be exported directly or
indirectly, separately or as part of any system, without first obtaining a license from the U.S. Department
of Commerce or any other appropriate agency of the U.S. Government, as required.

6. Restrictions on Use. End User acknowledges that one of FileNet's Third Party Providers provides
application integration software as part of the Software (the "Integration Software"). End User agrees to
use the Software solely as follows: (i) FileNet's workflow or content management software will be the
triggering source and/or the destination of the transaction managed by the Integration Software; (ii)
FileNet's workflow or content management functionality must be a necessary part of the transaction
managed by the Integration Software such that without such FileNet functionality, the transaction
managed by the Integration Software could not process; (iii) the Software will not be used or configured
in such a way as to only provide the functionality that the Integration Software provides; and (iv) all
derivative works of the Software made by or for End User are subject to the foregoing restrictions.

7. Choice of Law. The laws of the State of California will govern the construction and operation of this
Agreement without regard to the conflict of laws provisions thereof.

8. U.S. Government Restricted Rights. The Software is Commercial Software and the Software and
Documentation are provided with Restricted Rights. Use, duplication or disclosure by the Government is
subject to restrictions as set forth in paragraph (c) (1) (ii) of the Rights in Technical Data and Computer
Software Clause at DFARS 252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial
Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is
FileNet Corporation, 3565 Harbor Blvd., Costa Mesa, California 92626.
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